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Hydran M2 Host (DNP)
SAFETY WARNINGS IN SIX LANGUAGES

[EN] (in English) WARNINGS:

• All procedures in this manual must be strictly adhered to.
• Any deviation from these could cause irreversible damages to the transformer

being monitored and/or the Hydran M2, and could lead to property damage,
personal injury and/or death.

• Installation and maintenance of the Hydran M2 must be carried out by qualified
personnel only. Please advise station operator prior to maintenance. Working
inside the Hydran M2 may trigger unwanted alarms due to parameter changes,
power shutdown, system rebooting or electrostatic discharge.

• For a maximum distance of 15 m (50 ft) from the power source, use a 14-AWG
(2.08 mm2) cable and an overcurrent protection.

• The Hydran M2 is intended for industrial use and shall not be connected to the
public low-voltage supply system.

[FR] (in French) ATTENTION :

• Toutes les procédures dans ce manuel doivent être observées rigoureusement.
• Tout écart par rapport à celles-ci pourrait causer des dommages irréversibles au

transformateur surveillé et/ou au Hydran M2, et pourrait entraîner des dommages
à la propriété, des blessures corporelles et/ou la mort.

• L’installation et l’entretien du Hydran M2 doivent être effectués par du personnel
qualifié seulement. Veuillez aviser l’opérateur du poste avant l’entretien.
Travailler à l’intérieur du Hydran M2 peut déclencher des alarmes non voulues
en raison de changements à des paramètres, d’arrêt de l’alimentation, de remise
en marche du système ou de décharge électrostatique.

• Pour une distance maximale de 15 m (50 pi) de la source d’alimentation, utiliser
un câble de 14 AWG (2,08 mm2) et une protection contre les surintensités.

• Le Hydran M2 est destiné à un usage industriel et ne doit pas être branché au
système public d’alimentation à basse tension.
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[ES] (in Spanish) ADVERTENCIA:

• Se debe cumplir estrictamente con todos los procedimientos señalados en este
manual.

• Cualquier desviación al respecto puede causar daños irreparables al
transformador que está bajo monitoreo y/o al Hydran M2, asimismo puede ser
causa de daños materiales, lesiones corporales y/o muerte.

• La instalación y mantenimiento del equipo Hydran M2 se reserva únicamente al
personal perfectamente cualificado. Aconseje por favor a operador de la estación
antes del mantenimiento. El trabajo dentro del Hydran M2 puede accionar
alarmas indeseadas debido a los cambios del parámetro, parada de la energía,
sistema que reanuda o descarga electrostática.

• Para una distancia máxima de 15 m (50 pies) de la fuente de alimentación, utilice
un cable de 14-AWG (2,08 mm2) y una protección contra las sobrecargas de
corriente.

• El Hydran M2 se piensa para el uso industrial y no será conectado con el sistema
de fuente de baja tensión público.

[DE] (in German) WARNUNG:

• Alle Abläufe in diesem Handbuch müssen strengstens befolgt werden.
• Jede Abweichung davon könnte dem zu überwachenden Transformator und/oder

dem Hydran M2 unwiderrufliche Schäden zufügen, und könnte zu Sachschaden,
Personenverletzung und/oder Tod führen.

• Installation und Wartung des Hydran M2 dürfen daher nur von qualifiziertem
Personal durchgeführt werden. Verständigen Sie bitte den Bediener der
Schaltanlage vor der Wartung. Das Arbeiten innerhalb des Hydran M2 kann
aufgrund von Parameteränderungen, Spannungsabschaltung, Neubooten des
Systems oder elektrostatischer Entladung unerwartete Alarme auslösen.

• Für eine maximale Entfernung von 15 m von der Spannungsquelle, verwenden
Sie ein 14 AWG Kabel (2,08 mm2) und ein Überstromschutz.

• Der Hydran M2 ist für industriellen Einsatz vorgesehen und soll nicht an das
öffentliche Niederspannungs-Versorgungssystem angeschlossen werden.
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[IT] (in Italian) ATTENZIONE:

• Tutte le procedure del presente manuale dovranno essere eseguite in totale
conformità.

• Qualsiasi deviazione dallo stesso manuale potrebbe causare danni irreversibili al
trasformatore sotto monitoraggio e/o all’ Hydran M2, e potrebbe causare danni
alla proprietà, lesioni personali e/o alla morte.

• L’installazione e la manutenzione del Hydran M2 devono essere eseguite solo ed
esclusivamente da personale qualificato. Avissare l’operatore della stazione
prima di manutenzione. Funzionando all’interno del Hydran M2 può fare scattare
degli alarmi indesiderabili e cambiamenti dei parametri, arresto
dell’alimentazione, un “reboot” del sistema o scarico elettrostatico.

• A una distanza massima di 15 m dalla fonte di energia usare un cavo 14-AWG
(2.08 mm2) e una protezione di sovracorrente.

• L’intenzione del Hydran M2 è per uso industriale e a non collegare al sistema di
bassa tensione pubblico.

[SV] (in Swedish) VARNING:

• Alla procedurer i manualen måste följas noggrant.
• Varje avvikelse från dessa procedurer kan orsaka oåterkalleliga skador på den

övervakade transformatorn och/eller på Hydran M2 samt leda till
egendomsförlust, personskada och/eller livsfara.

• Installation och underhåll av Hydran M2 måste utföras av behörig personal. Råd
var god posterar operatören före underhåll. Funktionsduglig insida Hydran M2
kan starta oönskade parameterändringar för larm tack vare, driver avstängning,
systemomstart eller elektrostatisk urladdning.

• För ett maximalt avstånd på 15 m från kraftuttaget, använd 2,08 mm2 kabel
(14-AWG) och ett överströmsskydd.

• Hydran M2 ämnas för industriellt bruk och förbinds inte till det offentliga
tillförselsystemet för låg spänning.
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Hydran M2 Host (DNP)
PREFACE

This manual provides installation and operation instructions for the Hydran M2 Host
(DNP) software included in the Hydran M2, which is a unique, continuous, on-line monitor
of combustible gases and moisture in dielectric oils. See the Hydran M2 Instruction
Manual for additional information.

The information in this manual may be used by:

• A purchaser/specifier
• An installer
• A maintenance technician
• An engineer/designer
• An operator

This manual is not a tutorial on combustible gases or water in dielectric oil. It is assumed
that the reader is already familiar with these subjects.

This manual is written for the 0–2,000 ppm operating range only. This range is the one used
by most Hydran M2’s. Should your Hydran M2(’s) use a different operating range, please
convert the values (in doubt, contact the General Electric Canada Customer Service; the
coordinates can be found at the bottom of page ii).

To help the reader, a Table of Contents and a List of Figures are present at the beginning of
the manual, along with a Glossary in Appendix C.

The name of menus, options, parameters, etc. shown on the screen of the Hydran M2 Host
(DNP) software are displayed in bold characters; for example: the Network Survey
window.

CAUTIONWARNING
All procedures in this manual must be strictly adhered to. Any
deviation from these could cause irreversible damages to the
Hydran M2 and/or the transformer being monitored, and could lead
to property damage, personal injury and/or death. Installation and
maintenance of the Hydran M2 must be carried out by qualified
personnel only.
Part 17659 Rev. 6, December 2010 vii
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The Hydran M2 Host (DNP)’s menus and options can be embedded; to indicate the path to
a submenu, an option or a parameter, the symbol “>” is used to separate each step towards
this item.

The Hydran M2 (DNP) Host Software Manual (this manual), the Instruction Manual for
the Hydran M2 With Models and the Hydran M2 Installation Guide are located in PDF
format in the English/Manuals folder of the Hydran M2 installation CD. Hard copies of
each manual can be purchased from General Electric Canada.
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DATES OF REVISIONS

All pages in this manual are labeled “Rev. 6, December 2010” since they all have been
modified during this general revision.

Issue dates of this manual are:

Original (Rev. 1) . . . . . .August 2006

Revision 2 . . . . . . . . . . . . .May 2007

Revision 3 . . . . . . . . . . January 2009

Revision 4 . . . . . . . . . . .August 2009

Revision 5 . . . . . . . . . . . . .May 2010

Revision 6 . . . . . . . . December 2010
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Hydran M2 Host (DNP)
STANDARD GENERAL ELECTRIC CANADA WARRANTY

The products covered by this manual and manufactured by General Electric Canada
(“Products”) are warranted to be free from defects in material, workmanship and title at the
time of delivery. Any components of a Product or other products manufactured by persons
other than General Electric Canada carry only the warranty provided by the manufacturers
thereof and General Electric Canada gives no warranty on behalf of the manufacturers of
such products.

General Electric Canada warrants the Products until 36 months from date of delivery
(“Warranty Period”).

General Electric Canada represents and warrants that any software and firmware covered
by this manual is free from functional deficiencies. If any functional deficiencies are
discovered and are reported to General Electric Canada within the Warranty Period,
General Electric Canada agrees to use due diligence to correct such deficiencies within
30 days after receipt of such notification. Upon receiving such notice, General Electric
Canada may lend telephone support or patches. If the reported deficiencies cannot be
eliminated within 30 days, the Buyer may request, and General Electric Canada shall then
furnish, monthly status reports to the Buyer regarding the progress of General Electric
Canada’s efforts to correct such functional deficiencies.

If Products covered by this manual do not meet the above warranties during the applicable
Warranty Period, the Buyer shall promptly notify General Electric Canada in writing but
not later than 30 days and make the Products available promptly for correction. General
Electric Canada shall thereupon correct any defect by, at its option, repairing the defective
Products or making available necessary replacement parts.

Any failure which is the basis for a warranty claim shall not be cause for extension of the
duration of the applicable Warranty Period. General Electric Canada shall not be
responsible for removal or replacement of systems, structures or other parts of the Buyer’s
facility. If a defect in Products or part thereof cannot be corrected by General Electric
Canada’s reasonable efforts, the parties shall negotiate an equitable adjustment in price
with respect to such Products or part thereof. All decontamination work necessary for the
correction of defects shall be performed by the Buyer at the Buyer’s expense. The condition
of any tests shall be mutually agreed upon and General Electric Canada shall be notified of
and may be represented at all tests that may be made.
Part 17659 Rev. 6, December 2010 xi
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General Electric Canada does not warrant Products or any repaired or replacement parts
against normal wear and tear, including that due to environment or operation, including
excessive operation at peak capability, frequent starting, type of fuel, detrimental air inlet
conditions, or erosion, corrosion or material deposits from fluids, or which have been
involved in an accident. The warranties and remedies set forth herein are further
conditioned upon:

• Proper storage, installation, operation and maintenance of the Buyer’s equipment and
conformance with the instruction manuals (including revisions thereto) provided by
General Electric Canada and/or its subcontractors, as applicable

• Repair or modification pursuant to General Electric Canada’s instructions or approval

The Buyer shall keep proper records of operation and maintenance during the applicable
Warranty Period. These records shall be kept in the form of log sheets and copies shall be
submitted to General Electric Canada upon its request in connection with a warranty claim
by the Buyer. General Electric Canada does not warrant any products or services of others
designated by the Buyer where such products or services are not normally supplied by
General Electric Canada.

The preceding paragraphs set forth the exclusive remedies for all claims based on failure of
or defect in Products covered by this manual, whether the failure or defect arises before or
during the applicable Warranty Period and whether a claim, however instituted, is based on
contract, indemnity, warranty, tort (including negligence) or civil liability, strict liability or
otherwise. The foregoing warranties are exclusive and are in lieu of all other warranties and
guarantees whether written, oral, implied or statutory. NO IMPLIED STATUTORY
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE SHALL APPLY.
xii Rev. 6, December 2010 Part 17659
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Chapter 1

Software Installation

This Chapter explains how to install the Hydran M2 Host (DNP) software on a stand-alone
computer. Network installation is not supported.

Note: In Microsoft Windows 2000 settings (Control Panel > Display > Appearance menu),
select the Windows Standard under the Scheme list in order to get full window’s title. Do
not load the Hydran M2 Host (DNP) software in the DOS environment. You may install the
Hydran M2 Host (DNP) software as many times as needed.

1.1 SYSTEM REQUIREMENTS

• PC running Microsoft Windows, recommended Pentium* III, 1 GHz, 256 MB of
available RAM memory

• Hard disk with 2 GB of free space plus 0.4 MB per Hydran M2 per month
• Display mode resolution (pixels): XGA (1024 x 768), SXGA (1280 x 1024), or UXGA

(1600 x 1200)
• Microsoft Windows-compatible printer (optional)
• Microsoft Windows 2000, XP, Vista or Windows 7
• Null-modem serial cable

Note: The Hydran M2 Host (DNP) software has only been tested with the English version
of Microsoft Windows.

1.2 SHIPPING LIST

The Hydran M2 Host (DNP) package contains:

• Installation CD that includes the following items:
– The Hydran M2 Host (DNP) software
– The latest version of the embedded programs (firmware)
– The Hydran M2 (DNP) Host Software Manual (this manual), the Instruction Manual

for the Hydran M2 With Models and the Hydran M2 Installation Guide in PDF format
• One six-foot RS-232 standard communication cable with DB-9 female connectors at

both ends
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• One printed Hydran M2 Installation Guide

1.3 INSTALLING THE DNP SERVER

This Section explains how to install the DNP Server on a PC running a Microsoft Windows
operating system.

The DNP Server is a software component that controls the communication between the
Host application and the Hydran M2 network. The DNP Server supports true client server
architecture, thus enabling many PC’s running the Hydran M2 Host (DNP) application to
connect to the PC running the DNP Server application. Therefore, the DNP Server can be
installed on a separate PC being a server or on the same PC as the Hydran M2 Host (DNP)
application.

Note: You may install the software as many times as needed.

To install the DNP Server on a Microsoft Windows PC, follow these steps:

1. Close all running applications.

2. Insert the installation CD into the CD-ROM drive.

CAUTIONWARNING
Before installing the Hydran M2 Host (DNP) software, please read
the License Agreement in Appendix A.
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3. The installation begins automatically and the Software CD-ROM box shown in
Figure 1-1 on page 1-3 is displayed.

Note: If this box does not appear, click Start and select Run. Type X:\setup.exe (where X
is the drive letter associated with the CD-ROM drive) into the text box, and then click OK.

• To quit the installation procedure, click the button shown on the right or the X in
the top right corner.

Figure 1-1 - Software CD-ROM Box
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4. Click DNP SERVER. The DNP Server InstallShield Wizard box shown in
Figure 1-2 on page 1-4 appears.

Note: If a check mark [] is present to the left of DNP SERVER V x.x in Figure 1-1 on
page 1-3, it means that the DNP Server is already installed. Proceed directly to Section 1.4
on page 1-10 to install the Hydran M2 Host (DNP) application.

• To quit the installation procedure, click Cancel. The Exit Setup box shown in Figure 1-3
on page 1-4 is displayed.

– To exit the installation procedure, click Yes.
– To continue, click No.

Figure 1-2 - DNP Server InstallShield Wizard Box

Figure 1-3 - Exit Setup Box
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5. The DNP Server Welcome box shown in Figure 1-4 on page 1-5 appears.

• To quit the installation procedure, click Cancel or the X in the top right corner.
• To continue, read the statement and click Next >.

Figure 1-4 - DNP Server Welcome Box
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6. The DNP Server Choose Destination Location box shown in Figure 1-5 on page 1-6
is used to select the destination folder for the DNP Server software files.

• To return to Figure 1-4 on page 1-5, click < Back.
• To quit the installation procedure, click Cancel or the X in the top right corner in

Figure 1-5 on page 1-6.
• The default destination folder is C:\Program Files.
• To select another folder, click Browse....
• When the desired folder is indicated in the Destination Folder area, click Next >. The

default or selected folder is created if it does not exist.

Note: It is strongly recommended to accept the default directory that you are asked to
confirm.

Figure 1-5 - DNP Server Choose Destination Location Box
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7. The installation program has now collected enough information to start copying the
DNP Server software files into the destination folder. The DNP Server Start
Copying Files box shown in Figure 1-6 on page 1-7 presents the current settings.

• To quit the installation procedure, click Cancel or the X in the top right corner.
• To modify any setting, click < Back.
• If you are satisfied with the settings, click Next > to begin copying the files into the

destination folder.

Figure 1-6 - DNP Server Start Copying Files Box
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8. The DNP Server Setup Status progress box shown in Figure 1-7 on page 1-8 is
displayed.

• To quit the installation procedure, click Cancel or the X in the top right corner.

Figure 1-7 - DNP Server Setup Status Progress Box
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9. After all DNP Server software files have been successfully copied into your
computer, the DNP Server InstallShield Wizard Complete box shown in Figure 1-8
on page 1-9 appears.

• Click Finish >.

Figure 1-8 - DNP Server InstallShield Wizard Complete Box
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1.4 INSTALLING THE HYDRAN M2 HOST (DNP) APPLICATION

Once the DNP Server is installed, the next step consists in installing the Hydran M2 Host
(DNP) application.

1. The Software CD-ROM box shown in Figure 1-1 on page 1-3 is displayed once
more, and a check mark [] is present to the left of DNP SERVER.

2. Click Hydran M2 Host (DNP). The Hydran M2 Host (DNP) InstallShield Wizard
box shown in Figure 1-9 on page 1-10 appears.

• To quit the installation procedure, click Cancel. The Exit Setup box shown in Figure 1-3
on page 1-4 is displayed.
– To exit the installation procedure, click Yes.
– To continue, click No.

Figure 1-9 - Hydran M2 Host (DNP) InstallShield Wizard Box
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3. The Hydran M2 Host (DNP) Welcome box shown in Figure 1-10 on page 1-11
appears.

• To quit the installation procedure, click Cancel or the X in the top right corner.
• To continue, read the statement and click Next >.

Figure 1-10 - Hydran M2 Host (DNP) Welcome Box
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4. The Hydran M2 Host (DNP) Choose Destination Location box shown in
Figure 1-11 on page 1-12 is used to select the destination folder for the Hydran M2
Host (DNP) software files.

• To return to Figure 1-10 on page 1-11, click < Back.
• To quit the installation procedure, click Cancel in Figure 1-11 on page 1-12.
• The default destination folder is C:\Program Files.
• To select another folder, click Browse....
• When the desired folder is indicated in the Destination Folder area, click Next >. The

default or selected folder is created if it does not exist.

Note: It is strongly recommended to accept the default directory that you are asked to
confirm.

Figure 1-11 - Hydran M2 Host (DNP) Choose Destination Location Box
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5. The installation program has now collected enough information to start copying the
Hydran M2 Host (DNP) software files into the destination folder. The Hydran M2
Host (DNP) Start Copying Files box shown in Figure 1-12 on page 1-13 presents the
current settings.

• To quit the installation procedure, click Cancel or the X in the top right corner.
• To modify any setting, click < Back.
• If you are satisfied with the settings, click Next > to begin copying the files into the

destination folder.

Figure 1-12 - Hydran M2 Host (DNP) Start Copying Files Box
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6. The Hydran M2 Host (DNP) Setup Status progress box shown in Figure 1-13 on
page 1-14 is displayed.

• To quit the installation procedure, click Cancel or the X in the top right corner.

Figure 1-13 - Hydran M2 Host (DNP) Setup Status Progress Box
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7. After all Hydran M2 Host (DNP) software files have been successfully copied into
your computer, the Hydran M2 Host (DNP) InstallShield Wizard Complete box
shown in Figure 1-14 on page 1-15 appears.

• Click Finish >.

The software installation is now completed. Chapter 2 explains how to start up the
Hydran M2 Host (DNP) software, how to configure a network of Hydran M2 devices, and
then how to select the mode of operation.

Figure 1-14 - Hydran M2 Host (DNP) InstallShield Wizard Complete Box
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Chapter 2

Managing Device Connections

This Chapter explains how to start up the Hydran M2 Host (DNP) software, how to
configure a network of Hydran M2 devices, and then how to select the mode of operation.

2.1 STARTING UP THE HYDRAN M2 HOST (DNP) SOFTWARE

1. To start up the software, click Start, bring the cursor on All Programs and on GE
Energy (or the destination folder selected in Figure 1-11 on page 1-12), and then
click Hydran M2 Host (DNP). The Database Upgrade Utility box shown in
Figure 2-1 on page 2-1 is displayed.

• To upgrade the current database with a previously-saved database from another Host
version, click Yes.

• To continue without upgrading the database, click No.

Figure 2-1 - Database Upgrade Utility Box
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2. If Yes has been selected in Figure 2-1 on page 2-1, the box shown in Figure 2-2 on
page 2-2 appears.

• To cancel the operation and continue to start up the Hydran M2 Host (DNP) software,
click Cancel or the X in the top right corner.

• Select a previously-saved version of the database, which must be named Hydran.mdb.
• Click Open.

Figure 2-2 - Database Selection Box
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Passwords
3. The Database Upgrade Utility progress box shown in Figure 2-3 on page 2-3
appears in the middle of the screen while the database is being upgraded.

4. The Splash Screen shown in Figure 2-4 on page 2-3 appears in the middle of the
screen while the software is loading.

2.2 PASSWORDS

Access to the Hydran M2 Host (DNP) software is protected by two passwords:

• Level-1 password: 1253  
• Level-2 password: 1231  

Note: There is also a level-3 password that is restricted to General Electric Canada
employees.

Figure 2-3 - Database Upgrade Utility Progress Box

Figure 2-4 - Splash Screen
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Each higher-level password encompasses the functionalities of lower-level passwords. The
level-1 password provides access to some windows and commands and is also needed to
modify the Hydran M2 configuration. The level-2 password is required for most of the
setup commands, such as:

• Clearing and setting history files
• Modifying sensor cell parameters
• Installing a new sensor
• Upgrading a Hydran M2’s embedded program
• Changing the station identification number

The Password box shown in Figure 2-5 on page 2-4 is displayed when an online
connection is established.

• To cancel the operation and return to the previous window, click Cancel or the X in the
top right corner. In this case, level-0 (read-only) access is granted.

• Enter the level-1 (1253) or level-2 (1231) password, and click OK.

Once a password has been correctly entered, it remains in effect for 30 minutes. During this
period, if the Hydran M2 Host (DNP) software is not closed, the password does not need to
be entered again when required. After this period, the password is reset to level-0.

If there are settings that appear as read-only, this is because a higher-level password is
required. To enter it, select Security in the Options menu, enter the password in Figure 2-5
on page 2-4, and click OK.

Figure 2-5 - Password Box
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2.3 CONFIGURING THE DNP SERVER, THE POWER STATIONS AND THE 
DEVICES

2.3.1 Hierarchical Structure

The first time the Hydran M2 Host (DNP) software is started, the DNP Server, the Power
Stations and the Devices must be configured. The hierarchichal structure of these
components is as follows:

• DNP Server (Section 2.3.2 on page 2-6): A computer on which the DNP Server software
is installed. Every DNP Server contains one or many Power Stations.

• Power Station (Section 2.3.3 on page 2-8): A group of Devices connected in a daisy
chain. The connections to a Power Station can be either RS-232, Ethernet (via copper
wires or fiber optic), or modem.

• Device (Section 2.3.4 on page 2-9): A Hydran M2. Every Device has an ID number to
identify it when it is in a daisy chain.

The System Manager box shown in Figure 2-6 on page 2-6 is used to configure the
Hydran M2 networks. It opens automatically when the Hydran M2 Host (DNP) software is
started, or when Change Work Mode is selected in the Options menu.

• The left side displays the Power Stations and Devices in a tree structure.
• To show the Devices contained in a Power Station, click the + on its left.
• To hide the Devices contained in a Power Station, click the - on its left.
• To see (on the right side) the parameters of a Power Station or a Device, select its name

on the left side.
• To save the modifications brought to parameters, click Save.
• To exit this box, click Exit or the X in the top right corner.
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2.3.2 Adding a DNP Server

The first time the Hydran M2 Host (DNP) software is started, the Add DNP Server box
shown in Figure 2-7 on page 2-6 opens automatically. If this is not the first time, then click
Add Server in Figure 2-6 on page 2-6.

Note: Only one DNP Server can be installed on a single PC.

Figure 2-6 - System Manager Box

Figure 2-7 - Add DNP Server Box
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• Cancel: To cancel the operation.
• Server Display Name: The name of the DNP Server.
• DNP Server Network Name: The network name of the computer on which the DNP

Server is being created.
• Browse: To display a list of the computers currently found on the network. The box

shown in Figure 2-8 on page 2-7 appears.

– Close: To cancel the operation.
– Click the name of the computer on which the DNP Server is installed.
– Click OK.

• OK (in Figure 2-7 on page 2-6): To create the DNP Server with the parameters entered.

Figure 2-8 - Computer Names Box
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2.3.3 Adding a Power Station

In Figure 2-6 on page 2-6, click Add Power Station. The right side of the System
Manager box can then be used to configure the Power Station parameters (see Figure 2-9
on page 2-8).

• Power Station Name: The name of the Power Station.
• Power Station ID: The identification number of the Power Station.
• Connection Type: The way the Power Station can be connected. Select between:

– HM2 RS-232 
– Hydran controller: A Hydran 201Ci-C or Hydran 201Ci-4 Controller
– TCP/IP 
– MODEM 

• COM Port:
– For RS-232 and Hydran 201Ci Controller connections: The port to which a

Hydran M2 is connected.
– For modem connections: The port to which the internal or external modem is

connected.

Figure 2-9 - Adding a Power Station in the System Manager Box
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• Baud Rate: The speed of the connection
– For RS-232 connections: The same speed must be configured in the Hydran M2.
– For Hydran 201Ci Controller connections: The speed must be 19,200 bps or lower.
– For modem connections: The speed must be 19,200 bps or lower.
– For Ethernet (via copper wires or fiber optic): The Ethernet card should be configured.

• TCP/IP Port (for TCP/IP only): The port used by the Hydran M2’s Ethernet card.
• TCP/IP Address (for TCP/IP only): The IP address of the Hydran M2’s Ethernet card.
• Modem String (for modem only): The string sent to the computer’s modem in order to

initialize the connection. The default settings are &FX3&M0&D2, which is valid for
most modems.

• Phone Number: The number (without hyphens) to dial in order to reach the Device.
• Save: To create the Power Station with the parameters entered. The newly created Power

Station appears in the tree structure on the left side.
• Exit: To exit this box.

2.3.4 Adding a Device

In Figure 2-6 on page 2-6, select on the left side the Power Station to which you want to
add a Device, and click Add Device. The right side of the System Manager box can then
be used to configure the Device parameters (see Figure 2-10 on page 2-10).

• Device Name: The desired name for the Device.
• Monitor ID: The identification number of the Device.
• Power Station Name: The name of the Power Station to which the Device is being

added.
• Source DNP3 Address: The DNP address of the Server. It must be different from the

DNP addresses of all the Devices in the Power Station.
• Device DNP3 Address: The address of the Device. The same address must be

configured in the Hydran M2.
• Connection Timeout: The maximum period of time (in seconds) during which the

Hydran M2 Host (DNP) software will search for the connection, when connecting to a
Device.

• Request Timeout: The maximum period of time (in seconds) during which the
Hydran M2 Host (DNP) software will wait for a response, if the connection to a Device
is lost.

• Connect On Startup: If enabled [], the Hydran M2 Host (DNP) software attempts to
connect to this Device when clicking Online.

• Save: To create the Device with the parameters entered. The newly created Device
appears in the tree structure on the left side.
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• Exit: To exit this box.

2.3.5 Deleting a DNP Server, a Power Station or a Device

Proceed as follows in Figure 2-6 on page 2-6:

• DNP Server: Select the DNP Server in the drop-down list at the top, and click Remove
Server.

• Power Station: Select the Power Station in the tree structure on the left side, and click
Delete Power Station.

• Device: Select the Device in the tree structure on the left side, and click Delete Device.

A confirmation message similar to the one shown in Figure 2-11 on page 2-11 is displayed.

• No: To cancel the deletion.
• Yes: To delete the DNP Server, Power Station or Device.

Figure 2-10 - Adding a Device in the System Manager Box
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2.3.6 Changing the Software Language

The Hydran M2 Host (DNP) software supports two languages: English and Russian. To
select the desired language, click Select Language in the System Manager box
(Figure 2-6 on page 2-6). The box shown in Figure 2-12 on page 2-11 appears.

• To cancel the operation, click Cancel.
• From the drop-down menu, select English or Russian.
• Click Ok.

Figure 2-11 - Remove Power Station? Confirmation Box

Figure 2-12 - Select Language Box
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2.4 CONNECTING TO POWER STATIONS AND DEVICES

2.4.1 Updating the DNP Server

The DNP Server supports true client server architecture, thus enabling many PC’s running
the Hydran M2 Host (DNP) application to connect to the PC running the DNP Server appli-
cation.

The DNP Server Configuration Changed confirmation box shown in Figure 2-13 on
page 2-12 appears if all of the following conditions are met:

• The DNP Server is accessed by a Hydran M2 Host (DNP) software on one PC.
• Changes are made in the System Manager box (Figure 2-6 on page 2-6), such as adding

or deleting Power Stations or Devices.
• The System Manager box (Figure 2-6 on page 2-6) is accessed while connecting to the

DNP Server on another PC.

The DNP Server Configuration Changed confirmation box informs the user that changes
were made to the DNP Server configuration. Updating will allow seeing the changes done
by other Hydran M2 Host (DNP) applications connected to the Server.

• Yes: To update the DNP Server configuration.
• No: To leave the DNP Server as is. This might cause problems if major changes were

brought to the DNP Server configuration, since these changes will not be visible.

Note: It is strongly recommended to update the DNP Server configuration every time
Figure 2-13 on page 2-12 appears, in order to avoid working with outdated settings.

Figure 2-13 - DNP Server Configuration Changed Confirmation Box
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2.4.2 Changing the Work Mode and Device Connections

Once the Power Stations and Devices have been configured, two modes of operation are
available:

• Online (Section 2.4.3 on page 2-14)
• Offline (Section 2.4.4 on page 2-16)

Switching from one online or offline Power Station to another is possible without
closing the Hydran M2 Host (DNP) software. In the Options menu select Change
Working Mode, or click the button shown on the right. The Exit Current
Working Mode? confirmation box shown in Figure 2-14 on page 2-13 is displayed.

• Cancel: To cancel the operation.
• OK: To exit the current working mode. The System Manager box (Figure 2-6 on

page 2-6) then opens.
– Select a Server in the DNP Server drop-down list.
– Select a Power Station on the left side.
– Click Online.

It is also possible to modify the connection status of individual Devices within the current
Power Station. In the Options menu, select Connection, and the Device Connect/
Disconnect box shown in Figure 2-15 on page 2-14 appears.

Figure 2-14 - Exit Current Working Mode? Box
Part 17659 Rev. 6, December 2010 2-13



Chapter 2 • Managing Device Connections
• Cancel: To cancel the operation.
• Select a Device on the left side.
• Select either Connect or Disconnect on the right side.
• Apply: To apply the connection status to the selected Device without exiting the box.
• OK: To apply the connection status to the selected Device and exit this box.

2.4.3 Online

In each monitoring model, the Online mode of operation provides full access to the settings
in the Hydran M2 Host (DNP) software. It is used to modify the Hydran M2 configuration.
This mode is protected by a password to restrict access (see Section 2.2 on page 2-3).

In the Online mode, the Hydran M2 Host (DNP) software can perform all the operations
that could be done directly on the Hydran M2’s LCD screen, as well as many other
functions such as graphing and exporting data.

Figure 2-15 - Device Connect/Disconnect Box
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In this mode, each model reads data directly from the Hydran M2’s local Microsoft Access
database, using a direct communication link (modem or LAN) between the on-site
Hydran M2 and the system operator or supervisor computer running the Client application
software. The database is managed by Microsoft Access and data can be saved or altered.

To enter into the Online mode, follow the procedure in Section 2.4.2 on page 2-13.

Upon entering in Online mode from the System Manager box (Figure 2-6 on page 2-6),
the message box shown in Figure 2-16 on page 2-15 appears to confirm which Power
Station will be connected.

• To cancel the connection with the Power Station in the Online mode and return to the
System Manager box (Figure 2-6 on page 2-6), click No.

• To continue the operation, click Yes.

If the Power Station ID and the Device ID do not correspond with the values in the database,
the message box shown in Figure 2-17 on page 2-15 is displayed in order to inform the user
of a discrepancy.

• To cancel the connection with the Power Station in the Online mode and return to the
System Manager box (Figure 2-6 on page 2-6), click No.

• To continue the operation, click Yes.

Figure 2-16 - Connect Power Station in Online Mode Box

Figure 2-17 - Power Station ID and Device ID Not Corresponding Message Box
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2.4.4 Offline

In each monitoring model, the Offline mode of operation is used to consult the various
model windows and to select the displayed outputs. This mode provides limited function-
alities compared to the Online mode, and many settings cannot be modified; however a
connection to the device is not required.

The following options are available in the Offline mode:

• Network View
• Setup
• Service
• Display Settings
• History
• Models

Note: The values found in the Setup and Service windows for an offline Device are limited
to the values stored the last time the Device was online. If the Device has never been online,
the default values are displayed.

This mode is not protected by any password and is intended for the local utility manager
who wants access to the operating data from the Hydran M2 and the transformer.

In the Offline mode, each model reads data from the database located on the Client
application software computer, where the data must have been previously downloaded
from the Hydran M2’s local Microsoft Access database. In this mode, no direct communi-
cation link is used to review the data, and only the data previously imported can be
consulted or accessed.

To enter into the Offline mode, follow the procedure in Section 2.4.2 on page 2-13.
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Buttons and Menus

After the start-up of the Hydran M2 Host (DNP) software, the main window shown in
Figure 3-1 on page 3-1 is displayed.

Figure 3-1 - Main Window
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This Chapter explains the buttons and menus that are common to all windows of the
software. The buttons are described in Section 3.1 on page 3-2, and the menus are presented
in the following Sections:

• File Menu (Section 3.2 on page 3-3)
• View Menu (Section 3.3 on page 3-5)
• Configuration Menu (Section 3.4 on page 3-37)
• Options Menu (Section 3.5 on page 3-82)
• Window Menu: To select the active window
• Help (Section 3.6 on page 3-82)

3.1 BUTTONS

The set of buttons shown in Figure 3-2 on page 3-2 can be commonly used through the
various Hydran M2 Host (DNP) software windows. They are described below.

(or Exit in the File menu): To close the Hydran M2 Host (DNP) software. The
confirmation box shown in Figure 3-3 on page 3-2 appears.

• Yes: To exit the software application.
• No: To cancel the operation and return to the previous window.

(or Network View in the View menu): To display real-time measurements, model
values and input readings from the Hydran M2 units connected to the Hydran M2
Host (DNP) software. See Section 3.3.1 on page 3-5.

Figure 3-2 - Buttons

Figure 3-3 - Exit the Application? Box
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(or Models in the View menu): To select a model and display graphically real-time
or historic model values for a certain period of time. See Section 3.3.3 on
page 3-18.

 (or Setup in the Configuration menu): To configure the Input/Output modules,
alarms, models and history in the Hydran M2 Host (DNP) software. See
Section 3.4.2 on page 3-39.

(or Test in the Configuration menu): To test the relays, alarms and Hydran sensor
of the Hydran M2. See Section 3.4.3 on page 3-68.

 (or Service in the Configuration menu): To set the sensor parameters, to activate
models, and to view service data. See Section 3.4.4 on page 3-71.

 (or Change Working Mode in the Options menu): To switch from one online or
offline Power Station to another. See Section 2.4.2 on page 2-13.

 (or Print Screen in the File menu): To send the contents of the active window to
the Microsoft Windows default printer.

3.2 FILE MENU

The File menu includes three items:

• All History Download (Section 3.2.1 on page 3-3)
• Print Screen (Section 3.2.2 on page 3-4)
• Exit (Section 3.2.3 on page 3-4)

3.2.1 All History Download

This function is used to download all the history records contained in a Device:

• Short term records
• Long term records
• Events
• Alarms
• Service records
• Digital events
• DGA records
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Proceed as follows:

• Select the desired Device in the Network View window (Figure 3-8 on page 3-7). The
All History Download item becomes enabled in the File menu.

• In the File menu, select All History Download. The All History Download progress
box shown in Figure 3-4 on page 3-4 is displayed.

• After each type of history records has been downloaded, a checkmark [] appears to the
left of its name.

• When all history records have been downloaded, the progress box closes automatically.

3.2.2 Print Screen

In the File menu select Print Screen, or click the button shown on the right. The
contents of the active window is sent to the Microsoft Windows default printer.

3.2.3 Exit

In the File menu select Exit, or click the button shown on the right. The confir-
mation box shown in Figure 3-3 on page 3-2 appears.

• Yes: To exit the software application.
• No: To cancel the operation and return to the previous window.

Figure 3-4 - All History Download Progress Box
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3.3 VIEW MENU

The View menu is used to display information, and it includes six items:

• Network View (Section 3.3.1 on page 3-5)
• Real Time (Section 3.3.2 on page 3-9)
• Models (Section 3.3.3 on page 3-18)
• History (Section 3.3.4 on page 3-24)
• View & Update Last DGA (Section 3.3.5 on page 3-32)
• Test and Service (Section 3.3.6 on page 3-34)

3.3.1 Network View

The Network View is used to display real-time measurements, model values and input
readings from the Hydran M2 units connected to the Hydran M2 Host (DNP) software.

In the View menu select Network View, or click the button shown on the right.

The first time the Hydran M2 Host (DNP) software application is opened, the
Network View Parameters Not Configured box shown in Figure 3-5 on page 3-5 is
displayed since the Network View Parameters are not assigned yet for the selected Power
Station.

• Click OK.
• To select which parameters are displayed in the Network View, proceed as described in

Section 3.4.1 on page 3-37.

Figure 3-5 - Network View Parameters Not Configured Box
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When the parameters have been selected, the Network View window shown in Figure 3-6
on page 3-6 is displayed.

• The left side of the window illustrates the tree structure of the network. It can be used to
rapidly switch between Devices.

• The parameters (up to five) on the right side are the ones selected in Section 3.4.1 on
page 3-37, with the actual values.

• There is a group of up to five parameters and their actual values on the right side for each
Device in the Power Station.

• To visualize the real-time measurements, model values and input readings for a Device,
click its name in the tree structure on the left side.

• To close the window, click Close or the X in the top right corner.

Figure 3-6 - Network View Window for Power Station
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When clicking a Device’s name in the tree structure on the left side, the Reading Values
progress box shown in Figure 3-7 on page 3-7 appears in the middle of the screen.

After a few seconds, the Network View window shown in Figure 3-8 on page 3-7 is
displayed for the selected Device.

Figure 3-7 - Reading Values Progress Box

Figure 3-8 - Network View Window for Device
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• The left side of the window illustrates the tree structure of the network. It can be used to
rapidly switch between Devices.

• The Inputs tab is shown first for the selected Device.
• To see the Models or Hydran M2 readings tabs, click their name.
• To visualize the real-time measurements, model values and input readings for another

Device, click its name in the tree structure on the left side.
• To close the window, click Close or the X in the top right corner.

At the start-up of the Hydran M2 Host (DNP) software, when a Power Station is put online,
the software displays the Network View window for the Power Station with the selected
parameters of all the Devices.

The tree structure on the left side also quickly shows whether any of the Power Stations or
Devices detected any problems and displays active alarms:

• A green icon to the left of the Power Station’s or Device’s name indicates it is online with
no active alarms.

• A red icon indicates it is online with an active alarm.
• A grey icon indicates it is offline.
• If no alarms are present, the View Active Alarms button is disabled (grey).
• If there are active alarms, click View Active Alarms to view them. The Active Alarms

box shown in Figure 3-9 on page 3-8 appears.
– Select the alarm to acknowledge by clicking it.
– Click Acknowledge.
– Click Close.

To enable the other options in the View menu, the Network View window (Figure 3-8 on
page 3-7) must be opened for a specific Device. If the options are disabled (grey), open the
Network View window first.

Figure 3-9 - Active Alarms Box
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3.3.2 Real Time

The Real Time menu includes three items:

• Actual Values (Section 3.3.2.1 on page 3-9)
• Maximum Values (Section 3.3.2.2 on page 3-14)
• Enabled Alarms (Section 3.3.2.3 on page 3-16)

3.3.2.1 Actual Values

In the View menu, select Real Time and then Actual Values. The Reading Actual Values
progress box shown in Figure 3-10 on page 3-9 appears in the middle of the screen.

3.3.2.1.1 Inputs Tab

A few seconds later, the Inputs tab of the Actual Values window is displayed. In
Figure 3-11 on page 3-10, no digital inputs are connected.

Because the Hydran M2 is fully dynamic, the Hydran M2 Host (DNP) software displays
only the inputs, both analog and digital, that are connected to the Hydran M2 and
configured.

Analog inputs can be configured to display any of the following:

• Top oil temperature
• OLTC tank temperature
• Ambient temperature
• Tap position
• Winding H current
• Winding X current
• Winding Y current
• Any other input configured by the user

For information on how to configure the inputs, see Section 3.4.2.1 on page 3-41.

Figure 3-10 - Reading Actual Values Progress Box
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Since no digital inputs are connected to that particular Device, No Digital Inputs
Connected. is indicated in Figure 3-11 on page 3-10. If there are any digital inputs
connected, the Inputs tab of the Actual Values window is similar to Figure 3-12 on
page 3-11.

Digital inputs can be configured to display any of the following:

• Cooling Bank Status
• Transformer Energized Status
• Any other input configured by the user

For information on how to configure the digital inputs and their associated models, see
Section 3.4.2.1 on page 3-41.

Figure 3-11 - Inputs Tab of the Actual Values Window Without Digital Inputs
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Figure 3-12 - Inputs Tab of the Actual Values Window With Digital Inputs
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3.3.2.1.2 Models Tab

To view the values calculated by the models, click the Models tab. A window similar to
Figure 3-13 on page 3-12 appears.

The models displayed depend on the inputs connected to the Hydran M2 and will be
displayed automatically once the necessary inputs are connected. The models are discussed
in further detail in Chapter 6 to Chapter 14.

Figure 3-13 - Models Tab of the Actual Values Window
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3.3.2.1.3 Hydran M2 Readings Tab

To view the actual values read by the Hydran M2, click the Hydran M2 Readings tab. A
window similar to Figure 3-14 on page 3-13 is displayed.

The following readings can be measured by the Hydran M2 sensor:

• Hydran Readings:
– Hydran Level: The level of Hydran gas, in ppm
– Hydran Level Hourly Trend: The daily trend of Hydran gas in ppm/x hours, where

x is the Hourly Trend Period
– Hydran Level Daily Trend: The daily trend of Hydran gas in ppm/x days, where x is

the Daily Trend Period

Figure 3-14 - Hydran M2 Readings Tab of the Actual Values Window
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• Temperature Readings:
– Base Plate Temperature: The temperature (in °C) of the base plate that holds the

Hydran sensor
– Heater Power: The amount of power used by the base plate heater, in %
– Actual Temperature Set Point: The computed value of the temperature set point (in

°C) based on the modulation temperature settings
– Hydran Sensor Temperature: The temperature of the Hydran sensor, in °C

• Moisture Readings:
– %RH Level: The relative humidity, in %
– %RH at Standard Temperature: The relative humidity (in %) at the user-defined

standard temperature, used to compare RH% values from different transformers even
if the sensors are at different temperatures

– %RH Level Hourly Average: The average relative humidity (in %), computed over
the %RH Average Period

– H2O PPM Hourly Average: The average moisture level (in %), computed over the
%RH Average Period

– %RH Sensor Temperature Hourly Average: The average temperature of the
relative humidity sensor, in °C

– H2O PPM Level: The water content, in parts per million

3.3.2.2 Maximum Values

In the View menu, select Real Time and then Maximum Values. The Reading Maximum
Values progress box shown in Figure 3-15 on page 3-14 appears in the middle of the
screen.

Figure 3-15 - Reading Maximum Values Progress Box
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A few seconds later, the Temperature Values tab of the Maximum Values window is
displayed; see Figure 3-16 on page 3-15.

This window displays the maximum values set for the selected and configured inputs.

• To view the maximum load current values, click the Load Current Values tab.
• To view the maximum apparent power values, click the Apparent Power Values tab.
• To close the window, click Close or the X in the top right corner.

The following maximum values, along with their date and time, can be displayed:

• Temperature Values tab:
– Top Oil Temperature, in °C
– Bottom Oil Temperature, in °C
– Winding Hot-spot Temperature, in °C

Figure 3-16 - Maximum Values Window
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– OLTC Tank Temperature: The temperature of the tap changer tank, in °C
– Ambient Temperature, in °C

• Load Current Values tab:
– Current Winding H  
– Current Winding X  
– Current Winding Y  

• Apparent Power Values tab:
– Historic Max for MVA winding H  
– Historic Max for MVA winding X  
– Historic Max for MVA winding Y  

Note: Some inputs do not have any associated maximum values.

3.3.2.3 Enabled Alarms

In the View menu, select Real Time and then Enabled Alarms. The Enabled Alarms
window shown in Figure 3-17 on page 3-17 displays a complete list of the enabled alarms
along with their acknowledgement status.

Note: Some model-related alarms can only be generated if two specific models are enabled.
Appendix B presents the list of all alarm messages that can appear on the Hydran M2 Host
(DNP) software.

Some alarms could be off but not acknowledged; this occurs when an alarm condition is
present and then returns to normal. To ensure that the presence of this alarm is noticed, the
Acknowledgement Status remains as Pending.

The following properties are listed for each alarm:

• No.: The number of the alarm.
• Name: The name of the alarm.
• Alarm Level: The level of the alarm. 1st Level indicates a High or Low alarm, 2nd

Level indicates a High-High or Low-Low alarm, and Input Fault indicates an alarm due
to a system fault condition.

• Alarm Set Point: The maximum or minimum acceptable value before the alarm is
triggered.

• Present Value: The value measured currently.
• Alarm Status: Indicates if the alarm is ON or OFF. If an alarm is ON, the entire line is

highlighted in red.
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• Acknowledge Status: Can be blank (no active alarm), Pending (an alarm that is or has
been active but has not been acknowledged), or Acknowledged.

The following actions can be carried out:

• To acknowledge an alarm, select it and click Acknowledge.
• To close the window, click Close or the X in the top right corner.

Figure 3-17 - Enabled Alarms Window
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3.3.3 Models

In the View menu select Models, or click the button shown on the right. The View
Models window shown in Figure 3-18 on page 3-18 appears.

The available models are listed on the left side. For detailed explanation of the models, the
required inputs, the models outputs and the associated alarms, see Chapter 6 to Chapter 14.

Figure 3-18 - View Models Window With Real-Time Values
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3.3.3.1 Real Time Values

By default, Real Time Values is selected in Figure 3-18 on page 3-18. To display a
model’s real-time graph that is updated every 15 seconds, proceed as follows:

• Ensure Real Time Values is selected.
• Click the name of the desired real-time model on the left side.
• If Custom Screen is selected, see Section 3.3.3.1.1 on page 3-19.
• To close the window without generating a real-time graph, click Cancel or the X in the

top right corner.

Note: The commands available for all graphs are described in Chapter 5.

3.3.3.1.1 Custom Screen

The curves of up to ten analog inputs, digital inputs and/or calculated values from different
models can be graphed simultaneously. In Figure 3-18 on page 3-18, click Custom Screen,
and the Select Inputs box shown in Figure 3-19 on page 3-20 appears.

• The inputs enumerated in the Connected analog inputs and Connected digital inputs
areas depend on the inputs connected to the Hydran M2.

• The values listed in the Calculated values depend on the models enabled.
• Select [] up to ten analog inputs, digital inputs and/or calculated values by clicking

their name or on the checkbox to the left of each name.
• If the user tries to add an eleventh curve, a message box similar to Figure 3-39 on

page 3-39 appears. Click OK and remove [ ] at least one curve.
• To save the selections for future use, click Save and enter a name in the textbox that

appears.
• To reuse a custom configuration, select it in the Select custom configuration list.
• To delete a custom configuration, select it in the list and then click Delete.
• To clear the selected curves, click Clear.
• To close the box without generating a Custom Screen graph, click Cancel or the X in

the top right corner.
• To produce the desired Custom Screen graph, click OK.

A typical Custom Screen graph is shown in Figure 3-20 on page 3-21. Initially, there are
no curves, and real-time data appears as time passes.

Note: The commands available for all graphs are described in Chapter 5.
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Figure 3-19 - Select Inputs Box
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3.3.3.2 Historic Values

In the View Models window (Figure 3-18 on page 3-18), click Historic Values, and this
window becomes as shown in Figure 3-21 on page 3-22.

Note: Before trying to graph Historic Values, it is recommended to download all the
History of the Device to have it available. To do so, refer to Section 3.3.4 on page 3-24.

The Time Stamp and the Start Date are now enabled. Also, all the models now appear on
the left side, to allow graphing historic values if they exist.

Figure 3-20 - Typical Graph
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• Ensure Historic Values is selected.
• To display the historic values since a certain day, click Day and select the Start Date.

This will graph the selected model’s values from that day to the last available entry.
• To display the historic values since the beginning of a certain month, click Month and

select the Start Date. This will graph the selected model’s values from the beginning of
that month to the last available entry.

• To display the historic values during a certain period, click Range and select the Start
Date and then the End Date. This will graph the selected model’s values between the
two dates.

• Click the name of the desired model on the left side.

Figure 3-21 - View Models Window With Historic Values
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• Depending on the date range selected, some history records could have to be
downloaded. A confirmation box similar to Figure 3-22 on page 3-23 would appear.
Click Yes.

• During the download operation, a progress box similar to Figure 3-23 on page 3-23 is
displayed and then disappears automatically.

• If Custom Screen is selected, see Section 3.3.3.1.1 on page 3-19.
• To close the window without generating a real-time graph, click Cancel or the X in the

top right corner.

Note: The commands available for all graphs are described in Chapter 5.

Figure 3-22 - Download History? Confirmation Box

Figure 3-23 - History Download Progress Box
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If no History is available for the desired period of time, the History not available message
box shown in Figure 3-24 on page 3-24 appears.

• Click OK.
• Modify the Time Stamp, the Start Date and/or the End Date in Figure 3-21 on

page 3-22.

3.3.4 History

The Hydran M2 keeps History logs of measured values, alarms and other events. These
logs can be downloaded to a PC using the Hydran M2 Host (DNP) software. Once
downloaded, the History can be viewed in a grid or as a graph, or exported to a Microsoft
Excel or text file to be compatible with other office tools.

In the View Menu, select History. The History Options box shown in Figure 3-25 on
page 3-24 is displayed.

Figure 3-24 - History Not Available Box

Figure 3-25 - History Options Box
3-24 Rev. 6, December 2010 Part 17659



View Menu
The following types of History can be selected in the History drop-down list:

• Short Term: Contains the Hydran M2 measurements, recorded continuously every
periodic interval set by the user (default is 15 minutes).

• Long Term: Contains all the Hydran M2 measurements, recorded over a longer periodic
interval (up to four times a day).

• Event: Keeps track of changes made to settings such as alarm set points and user-defined
models. It also records down the date and time when the device was powered up and
powered down.

• Alarms: Keeps track of all alarms that were triggered and acknowledged, as well as all
the measured values at the time that the alarm occurred.

• Service: Stores the results of sensor tests.
• Digital Event: Keeps track of the status of alarm relays and other digital inputs, such as

cooling bank status and user-defined inputs.
• DGA History: Stores the values set for the digital gaz analyzer.

3.3.4.1 Viewing History in Grid Format

Each type of History log can be viewed in a grid. Proceed as follows:

• In the View Menu, select History.
• In Figure 3-25 on page 3-24, select the desired type in the History drop-down list.
• In the Type drop-down list, select Grid.
• Select the Start Date and the End Date for the data to be downloaded.
• To close the box without generating a grid, click Close or the X in the top right corner.
• To generate a grid, click OK.

If the desired type of History is unavailable during the selected period of time, the
Proceeding to Download History message box shown in Figure 3-26 on page 3-26
appears.

• Click OK.
• Wait for the History data to transfer from the Hydran M2 to the PC.

Note: The History download time is not proportional to the date range selected, but rather
on how much time has passed since the last History download. When OK is clicked, all
records of the selected type of History not currently in the PC’s database are downloaded
to ensure that the PC is completely up to date.
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Once the History has finished downloading, it is displayed in a grid. There are two types of
grid:

• The Short Term, Long Term and Service histories are displayed in a spreadsheet-type
format (see Figure 3-27 on page 3-27).

• For all the other types of history, there are two separate grids (see Figure 3-28 on
page 3-28):
– The grid on the left contains the Date and Time as well as the Event Description.
– Click an event in the grid on the left.
– The grid on the right presents the Value of each Variable at the time of the event

occurrence.

To close the grid, click Close or the X in the top right corner.

Figure 3-26 - Proceeding to Download History Box
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Figure 3-27 - Short Term, Long Term or Service History Grid
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3.3.4.2 Viewing Short Term, Long Term or Service History in Graphical Format

Only the Short Term, Long Term and Service histories can be viewed in a graph. Proceed
as follows:

• In the View Menu, select History.
• In Figure 3-25 on page 3-24, select Short Term, Long Term or Service in the History

drop-down list.
• In the Type drop-down list, select Graphical, and this box becomes as shown in

Figure 3-29 on page 3-29.
• Select the Start Date and the End Date for the data to be downloaded.
• Select [] up to ten parameters by clicking their name or the checkbox to the left of each

name.

Figure 3-28 - Other History Types
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• If the user tries to add an eleventh parameter, a message box similar to Figure 3-39 on
page 3-39 appears. Click OK and remove [ ] at least one parameter.

• To close the box without generating a graph, click Close or the X in the top right corner.
• To generate a graph, click OK.

If the desired type of History is unavailable during the selected period of time, the
Proceeding to Download History message box shown in Figure 3-26 on page 3-26
appears.

• Click OK.
• Wait for the History data to transfer from the Hydran M2 to the PC.

Figure 3-29 - History Options Box in Graphical Format
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Note: The History download time is not proportional to the date range selected, but rather
on how much time has passed since the last History download. When OK is clicked, all
records of the selected type of History not currently in the PC’s database are downloaded
to ensure that the PC is completely up to date.

Once the History has finished downloading, it is displayed in a graph similar to Figure 3-20
on page 3-21.

Note: The settings available for all graphs are described in Chapter 5.

3.3.4.3 Exporting History

The History logs can also be exported to a Microsoft Excel or text file to be compatible with
other office tools. Proceed as follows:

• In the View Menu, select History.
• In Figure 3-25 on page 3-24, select the desired type in the History drop-down list.
• In the Type drop-down list, select Export, and this box becomes as shown in Figure 3-30

on page 3-31.
• Select the format Excel.
• Select the Start Date and the End Date for the data to be downloaded.
• Select [] the desired parameters by clicking their name or the checkbox to the left of

each name, or click Select All if all are needed.
• To close the box without generating a file, click Close or the X in the top right corner.
• To generate a file, click OK.

If the desired type of History is unavailable during the selected period of time, the
Proceeding to Download History message box shown in Figure 3-26 on page 3-26
appears.

• Click OK.
• Wait for the History data to transfer from the Hydran M2 to the PC.

Note: The History download time is not proportional to the date range selected, but rather
on how much time has passed since the last History download. When OK is clicked, all
records of the selected type of History not currently in the PC’s database are downloaded
to ensure that the PC is completely up to date.
3-30 Rev. 6, December 2010 Part 17659



View Menu
Figure 3-30 - History Options Box in Export Format
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Once the History has finished downloading, an Exported History message box (see
Figure 3-31 on page 3-32) appears to show the path and name of the file created. The files
are saved in the Export subdirectory found in the Hydran M2 Host (DNP) installation
directory; the default directory is C:\Program Files\GE Energy\Hydran M2 Host
(DNP)\Export, which might have been modified in Figure 1-11 on page 1-12.

3.3.5 View & Update Last DGA

This function is used to enter DGA (Dissolved Gas Analysis) values obtained from oil
sample tests so that the Hydran M2 can perform more accurate model computations.

In the View Menu, select View & Update Last DGA. The box shown in Figure 3-32 on
page 3-33 is displayed. It presents the following data for the last DGA:

• The following gases, in ppm:
– H2: Hydrogen
– CO: Carbon monoxide
– CO2: Carbon dioxide
– CH4: Methane
– C2H6: Ethane
– C2H4: Ethylene
– C2H2: Acetylene
– N2: Nitrogen
– O2: Oxygen
– H2O: Water

• The computed value of the total gas content, in %
• The time stamp

Figure 3-31 - Exported History Message Box
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• To close this box, click Close.
• To update the last DGA or to enter a new one, click Update Last DGA. The fields can

now be edited, as can be seen in Figure 3-33 on page 3-34.

Figure 3-32 - View Last DGA Box
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• Update or enter the values for the various gases listed on page 3-32.
• Update or enter the time stamp.
• To clear the values displayed, click Clear.
• To save the new DGA, click Save New DGA.
• To close this box, click Close.

3.3.6 Test and Service

The Test and Service menu shows the status of the relays as well as the Hydran and
moisture sensor parameters.

Figure 3-33 - Update Last DGA Box
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In the View Menu, select Test and Service. The Reading Test and Service Values
progress box shown in Figure 3-34 on page 3-35 is displayed in the center of the screen.

A few seconds later, the Test tab of the Test and Service window appears; see Figure 3-35
on page 3-35.

• The status of the relay modes Alarm 1 to Alarm 4 and SysOK is indicated.
• To close the window, click Close or the X in the top right corner.

Figure 3-34 - Reading Test and Service Values Progress Box

Figure 3-35 - Test Tab of the Test and Service Window
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To see the Service tab, click its name and it is displayed; see Figure 3-36 on page 3-36.

The following information is provided:

• Sensor serial number
• Hydran sensor:

– Value of the parameters B, M, N, S and A1 to A6
– Value of the parameters checksum

• Moisture sensor:
– Value of the parameters C1 to C10
– Value of the parameters checksum

To close the window, click Close or the X in the top right corner.

Figure 3-36 - Service Tab of the Test and Service Window
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3.4 CONFIGURATION MENU

The Configuration menu is used to configure the different parameters, alarms, inputs,
outputs and all other characteristics of the Hydran M2.

The Configuration menu includes five items:

• Network View Parameter Selection (Section 3.4.1 on page 3-37)
• Setup (Section 3.4.2 on page 3-39)
• Test (Section 3.4.3 on page 3-68)
• Service (Section 3.4.4 on page 3-71)
• Display Settings (Section 3.4.5 on page 3-81)

3.4.1 Network View Parameter Selection

This function is used to select which parameters are displayed in the Network View
window (Figure 3-6 on page 3-6). Proceed as follows:

• In the Network View window (Figure 3-6 on page 3-6), select the desired Power Station.
• In the Configuration menu select Network View Parameter Selection, and the

Loading Network View Parameter Selection Values progress box shown in
Figure 3-37 on page 3-37 appears in the middle of the screen.

After a few seconds, the Network View Parameter Selection window shown in
Figure 3-38 on page 3-38 is displayed. It is used to select up to five parameters that will be
visible in the Power Station Network View.

• In the tree view in the left area, select the Device for which the real-time measurements,
model values and input readings will be displayed.

• The center area lists all the parameters available for the selected Device.
• The right area shows all the parameters already assigned for the selected Device.
• To cancel the operation, click Cancel or the X in the top right corner.
• To add a parameter to the Device’s Network View, highlight its name in the center area

and click >. The selected parameter moves to the right area.

Figure 3-37 - Loading Network View Parameter Selection Values Progress Box
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• To remove a parameter from the Device’s Network View, highlight its name in the right
area and click <. The selected parameter goes into the center area.

• As soon as the user adds a sixth parameter into the right area, the message box shown in
Figure 3-39 on page 3-39 appears. Click OK and remove at least one parameter from the
right area.

• When up to five parameters have been selected in Figure 3-38 on page 3-38, click Apply
and then OK.

Figure 3-38 - Network View Parameter Selection Window
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3.4.2 Setup

The Setup function is used to configure the Input/Output modules, alarms, models
and history in the Hydran M2 Host (DNP) software. In the Configuration menu
select Setup, or click the button shown on the right.

The Loading Device Data progress box shown in Figure 3-40 on page 3-39 is displayed in
the center of the screen.

A few seconds later, the Setup window appears; see Figure 3-41 on page 3-40.

• The left side displays the Setup tree structure.
• To expand a node, click the + on its left.
• To collapse a node, click the - on its left.
• To see (on the right side) the parameters of an item, select its name on the left side.
• To apply the modifications brought to parameters, click Apply.
• To exit this box without applying the modifications, click Cancel or the X in the top right

corner.

The expanded Setup tree structure is shown in Figure 3-42 on page 3-40.

Note: If a value is changed and Apply or OK is not clicked before moving to another item,
the Values Modified box shown in Figure 3-43 on page 3-41 appears to remind that the
changes have not been saved. Click Yes to save the changes or No to refuse them.

Figure 3-39 - Maximum Five Items Allowed Box

Figure 3-40 - Loading Device Data Progress Box
Part 17659 Rev. 6, December 2010 3-39



Chapter 3 • Buttons and Menus
Figure 3-41 - Setup Window

Figure 3-42 - Expanded Setup Tree
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3.4.2.1 Input-Output Setup

Input-Output Setup is used to configure the plugins and the communication port 2 used
for RS-485 and TDM communication. Four plugin slots are available on the Hydran M2 to
receive analog input, analog output and digital input cards.

Depending on the number and type of plugin cards, the Hydran M2 Host (DNP) software
displays different data. Figure 3-44 on page 3-41 illustrates the expanded Input-Output
Setup tree structure with four plugin slots full.

3.4.2.1.1 Analog Input Plugin

When the plugin card is an analog input 4–20 mA card, the following information is
displayed by clicking the plugin (see Figure 3-45 on page 3-42):

• Set the Range to 4-20 mA if the input to the card is to be between 4 and 20 mA.
• Set the Range to As Calibrated if the input to the card is calibrated for different currents.
• State: the actual reading of the input card. -25 % means no input current is detected.
• Value Selection: the parameter that is represented by the input card. It can be set to:

– None  
– User defined

Figure 3-43 - Values Modified Box

Figure 3-44 - Expanded Input-Output Setup Tree
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– Top Oil Temp  
– OLTC Tank Temp  
– Tap position  
– Winding H Current  
– Winding Y Current  
– Winding X Current  
– Ambient Temp  
– Bottom Oil Temp  

Proceed as follows:

• Select the desired settings.
• Click Apply.
• Click the + that appears to the left of the selected input (Plugin 1 in Figure 3-44 on

page 3-41). The expanded plugin setup tree is displayed (see an example in Figure 3-46
on page 3-43, where the input has been set to Top Oil Temperature).

• Click the input parameter configuration (Top Oil Temperature in Figure 3-46 on
page 3-43).

The properties to be changed differ depending on the parameter assigned to the input. If
Value Selection has been set to User defined in Figure 3-45 on page 3-42, the entries
shown in Figure 3-47 on page 3-43 appear.

• Enter the Minimum Value in %.
• Enter the Maximum Value in %.
• Enter the Input Resolution in %.
• To modify the input name, input units or reading precision, refer to Section 3.4.2.3 on

page 3-61.
• When the input is set up as desired, click Apply.

Figure 3-45 - Analog 4–20 mA Input Card
3-42 Rev. 6, December 2010 Part 17659



Configuration Menu
3.4.2.1.2 Analog Output Plugin

When the plugin card is an analog output 4–20 mA card, the following information is
displayed by clicking the plugin (see Figure 3-48 on page 3-44):

• Set the Sample Rate to the desired interval, in seconds.
• Set the Minimum Value that will correspond to an output of 4 mA.
• Set the Maximum Value that will correspond to an output of 20 mA.
• Set the Mode to Normal unless the output needs to be tested.

Figure 3-46 - Expanded Plugin Setup Tree

Figure 3-47 - Analog User Defined Input
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• Reading To Output: the parameter that is represented by the output card. It can be set to:
– None  
– %RH Level  
– H2O PPM Level  
– Hydran Level  
– Sensor Temp  
– %RH Temp  

When the output is set up as desired, click Apply.

3.4.2.1.3 Digital Input Plugin

Each digital input card can be associated to two digital inputs. When the plugin card is a
digital input card, click the plugin to obtain the information shown in Figure 3-49 on
page 3-44.

Figure 3-48 - Analog 4–20 mA Output Card

Figure 3-49 - Digital Input Card
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• Assign to #1 Output Model one of the available parameters:
– None  
– Cooling Bank 1  
– Cooling Bank 2  
– Trans. Energized  
– User Defined  

• Repeat for #2 Output Model.
• Click Apply.
• Click the + that appears to the left of the selected input.
• Click the input parameter configuration.

3.4.2.1.4 Comm #2 Setup

The Comm #2 port is always plugged-in. It is used for RS-485 communication but can also
be used as a TDM output. Click Comm #2(TDM Out) in Figure 3-44 on page 3-41, and
the entries shown in Figure 3-50 on page 3-45 appear.

• Set the Sample Rate to the desired interval, in seconds.
• Set the Minimum Value that will correspond to the TDM’s minimum output.
• Set the Maximum Value that will correspond to the TDM’s maximum output.
• Set the Mode to Normal unless the output needs to be tested.
• Reading To Output: the parameter that is represented by the output card. It can be set to:

– None  
– %RH Level  

Figure 3-50 - Comm #2 Setup
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– H2O PPM Level  
– Hydran Level  
– Sensor Temp  
– %RH Temp  

• Assign to TDM Out Relay A one of four relays (or None).
• Assign to TDM Out Relay B one of four relays (or None).
• Click Apply.

3.4.2.2 Alarm Setup

Appendix B presents the list of all alarm messages that can appear on the Hydran M2 Host
(DNP) software. The Alarm Setup options are shown in the expanded tree view in
Figure 3-51 on page 3-46.

There are several types of alarms associated with the Hydran M2 readings:

• Hydran alarms (Section 3.4.2.2.1 on page 3-47)
• Moisture alarms (Section 3.4.2.2.2 on page 3-51)
• Temperature alarms (Section 3.4.2.2.3 on page 3-54)

Figure 3-51 - Expanded Alarm Tree
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• Alarms due to system fault conditions
• Additional alarms that are available depending on the set inputs and models

For more details on which alarms are available with which model and associated inputs, see
Chapter 6 to Chapter 14.

3.4.2.2.1 Hydran Alarms

In Figure 3-51 on page 3-46, click the + to the left of Hydran. There are four types of
Hydran alarms that can be enabled or disabled:

• Hydran Level  
• Hydran Hourly Trend  
• Hydran Daily Trend  
• Hydran Sensor Test Alarm Setup  

In Figure 3-51 on page 3-46, click Hydran Level, and the menu shown in Figure 3-52 on
page 3-47 is displayed on the right side.

The following parameters can be adjusted:

• Alarm Delay, in minutes.

Figure 3-52 - Hydran Level Alarm
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• Enable [] or disable [ ] the High Alarm Set Point and/or High-High Alarm Set Point
by clicking the appropriate checkbox. Once an alarm is enabled, a check mark appears
in the box and the Set Point becomes enabled.

• If the High Alarm Set Point and/or High-High Alarm Set Point is enabled, set their
values in ppm.

• If required, assign an Alarm High Relay to the High Alarm Set Point.
• If required, assign an Alarm High-High Relay to the High-High Alarm Set Point.
• Click Apply to save the settings.

Note: There are only four relays available for all the alarms. Each relay can only accept
one alarm. Ensure there is only a total of four alarms assigned to the relays.

In Figure 3-51 on page 3-46, click Hydran Hourly Trend, and the menu shown in
Figure 3-53 on page 3-48 is displayed on the right side.

The following parameters can be adjusted:

• Alarm Delay, in % of period.

Note: To set the period, refer to Section 3.4.2.3.1 on page 3-61.

Figure 3-53 - Hydran Hourly Trend Alarm
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• Enable [] or disable [ ] the High Alarm Set Point and/or High-High Alarm Set Point
by clicking the appropriate checkbox. Once an alarm is enabled, a check mark appears
in the box and the Set Point becomes enabled.

• If the High Alarm Set Point and/or High-High Alarm Set Point is enabled, set their
values in ppm.

• If required, assign an Alarm High Relay to the High Alarm Set Point.
• If required, assign an Alarm High-High Relay to the High-High Alarm Set Point.
• Click Apply to save the settings.

In Figure 3-51 on page 3-46, click Hydran Daily Trend, and the menu shown in
Figure 3-54 on page 3-49 is displayed on the right side.

The following parameters can be adjusted:

• Alarm Delay, in % of period.

Note: To set the period, refer to Section 3.4.2.3.1 on page 3-61.

• Enable [] or disable [ ] the High Alarm Set Point and/or High-High Alarm Set Point
by clicking the appropriate checkbox. Once an alarm is enabled, a check mark appears
in the box and the Set Point becomes enabled.

• If the High Alarm Set Point and/or High-High Alarm Set Point is enabled, set their
values in ppm.

Figure 3-54 - Hydran Daily Trend Alarm
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• If required, assign an Alarm High Relay to the High Alarm Set Point.
• If required, assign an Alarm High-High Relay to the High-High Alarm Set Point.
• Click Apply to save the settings.

In Figure 3-51 on page 3-46, click Hydran Sensor Test Alarm Setup, and the menu
shown in Figure 3-55 on page 3-50 is displayed on the right side.

The following parameters can be adjusted:

• Enable [] or disable [ ] each of the following alarms by clicking the appropriate
checkbox:
– Sensor cable open
– Sensor cable short
– Replace sensor soon
– Replace sensor now

• If required, assign a relay to the enabled alarms.
• Click Apply to save the settings.

Figure 3-55 - Hydran Sensor Test Alarm
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3.4.2.2.2 Moisture Alarms

In Figure 3-51 on page 3-46, click the + to the left of Moisture Sensor. There are four types
of moisture sensor alarms that can be enabled or disabled:

• %RH Level  
• %RH Average  
• H2O PPM  
• H2O PPM Average  

In Figure 3-51 on page 3-46, click %RH Level, and the menu shown in Figure 3-56 on
page 3-51 is displayed on the right side.

The following parameters can be adjusted:

• Alarm Delay, in minutes.
• Enable [] or disable [ ] the High Alarm Set Point and/or High-High Alarm Set Point

by clicking the appropriate checkbox. Once an alarm is enabled, a check mark appears
in the box and the Set Point becomes enabled.

• If the High Alarm Set Point and/or High-High Alarm Set Point is enabled, set their
values in %.

• If required, assign an Alarm High Relay to the High Alarm Set Point.

Figure 3-56 - %RH Level Alarm
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• If required, assign an Alarm High-High Relay to the High-High Alarm Set Point.
• Click Apply to save the settings.

In Figure 3-51 on page 3-46, click %RH Average, and the menu shown in Figure 3-57 on
page 3-52 is displayed on the right side.

The following parameters can be adjusted:

• Alarm Delay, in % of period.

Note: To set the period, refer to Section 3.4.2.3.2 on page 3-62.

• Enable [] or disable [ ] the High Alarm Set Point and/or High-High Alarm Set Point
by clicking the appropriate checkbox. Once an alarm is enabled, a check mark appears
in the box and the Set Point becomes enabled.

• If the High Alarm Set Point and/or High-High Alarm Set Point is enabled, set their
values in %.

• If required, assign an Alarm High Relay to the High Alarm Set Point.
• If required, assign an Alarm High-High Relay to the High-High Alarm Set Point.
• Click Apply to save the settings.

Figure 3-57 - %RH Average Alarm
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In Figure 3-51 on page 3-46, click H2O PPM, and the menu shown in Figure 3-58 on
page 3-53 is displayed on the right side.

The following parameters can be adjusted:

• Alarm Delay, in minutes.
• Enable [] or disable [ ] the High Alarm Set Point and/or High-High Alarm Set Point

by clicking the appropriate checkbox. Once an alarm is enabled, a check mark appears
in the box and the Set Point becomes enabled.

• If the High Alarm Set Point and/or High-High Alarm Set Point is enabled, set their
values in ppm.

• If required, assign an Alarm High Relay to the High Alarm Set Point.
• If required, assign an Alarm High-High Relay to the High-High Alarm Set Point.
• Click Apply to save the settings.

In Figure 3-51 on page 3-46, click H2O PPM Average, and the menu shown in
Figure 3-59 on page 3-54 is displayed on the right side.

The following parameters can be adjusted:

• Alarm Delay, in % of period.

Note: To set the period, refer to Section 3.4.2.3.2 on page 3-62.

Figure 3-58 - H2O PPM Alarm
Part 17659 Rev. 6, December 2010 3-53



Chapter 3 • Buttons and Menus
• Enable [] or disable [ ] the High Alarm Set Point and/or High-High Alarm Set Point
by clicking the appropriate checkbox. Once an alarm is enabled, a check mark appears
in the box and the Set Point becomes enabled.

• If the High Alarm Set Point and/or High-High Alarm Set Point is enabled, set their
values in ppm.

• If required, assign an Alarm High Relay to the High Alarm Set Point.
• If required, assign an Alarm High-High Relay to the High-High Alarm Set Point.
• Click Apply to save the settings.

3.4.2.2.3 Sensor Temperature Alarm

In Figure 3-51 on page 3-46, click the + to the left of Sensor Temperature Alarm. There
are two types of sensor temperature alarms that can be enabled or disabled:

• Sensor Temperature  
• Base Plate Temperature  

In Figure 3-51 on page 3-46, click Sensor Temperature, and the menu shown in
Figure 3-60 on page 3-55 is displayed on the right side.

The following parameters can be adjusted:

• Alarm Delay, in minutes.

Figure 3-59 - H2O PPM Average Alarm
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• Enable [] or disable [ ] the Low-Low Alarm Set Point, Low Alarm Set Point, High
Alarm Set Point and/or High-High Alarm Set Point by clicking the appropriate
checkbox. Once an alarm is enabled, a check mark appears in the box and the Set Point
becomes enabled.

• If the Low-Low Alarm Set Point, Low Alarm Set Point, High Alarm Set Point and/
or High-High Alarm Set Point is enabled, set their values in °C.

• Enable [] or disable [ ] the Input Fault Alarm by clicking the appropriate checkbox.
Once this alarm is enabled, a check mark appears in the box.

• If required, assign an Alarm Low-Low Relay to the Low-Low Alarm Set Point.
• If required, assign an Alarm Low Relay to the Low Alarm Set Point.
• If required, assign an Alarm High Relay to the High Alarm Set Point.
• If required, assign an Alarm High-High Relay to the High-High Alarm Set Point.
• Click Apply to save the settings.

Figure 3-60 - Sensor Temperature Alarm
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In Figure 3-51 on page 3-46, click Base Plate Temperature, and the menu shown in
Figure 3-61 on page 3-56 is displayed on the right side.

The following parameters can be adjusted:

• Alarm Delay, in minutes.
• Enable [] or disable [ ] the Low-Low Alarm Set Point, Low Alarm Set Point, High

Alarm Set Point and/or High-High Alarm Set Point by clicking the appropriate
checkbox. Once an alarm is enabled, a check mark appears in the box and the Set Point
becomes enabled.

• If the Low-Low Alarm Set Point, Low Alarm Set Point, High Alarm Set Point and/
or High-High Alarm Set Point is enabled, set their values in °C.

• Enable [] or disable [ ] the Input Fault Alarm by clicking the appropriate checkbox.
Once this alarm is enabled, a check mark appears in the box.

• If required, assign an Alarm Low-Low Relay to the Low-Low Alarm Set Point.

Figure 3-61 - Base Plate Temperature Alarm
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• If required, assign an Alarm Low Relay to the Low Alarm Set Point.
• If required, assign an Alarm High Relay to the High Alarm Set Point.
• If required, assign an Alarm High-High Relay to the High-High Alarm Set Point.
• Click Apply to save the settings.

3.4.2.2.4 Battery Alarm

The battery alarm is used to monitor the internal battery in the Hydran M2 that keeps the
data in memory when the Hydran M2 is not powered.

In Figure 3-51 on page 3-46, click Battery, and the menu shown in Figure 3-62 on
page 3-57 is displayed on the right side.

The following parameters can be adjusted:

• Alarm Delay, in hours.
• Enable [] or disable [ ] the Low Alarm Set Point and/or Low-Low Alarm Set Point

by clicking the appropriate checkbox. Once an alarm is enabled, a check mark appears
in the box and the Set Point becomes enabled.

• If the Low Alarm Set Point and/or Low-Low Alarm Set Point is enabled, set their
values in volts.

• If required, assign an Alarm Low Relay to the Low Alarm Set Point.
• If required, assign an Alarm Low-Low Relay to the Low-Low Alarm Set Point.

Figure 3-62 - Battery Alarm
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• Click Apply to save the settings.

3.4.2.2.5 System Fault Triggers

When enabled, the System Fault Trigger alarms will turn on the System OK relay. This
serves to show that there might be a problem with the Hydran M2.

In Figure 3-51 on page 3-46, click System Fault Triggers, and the menu shown in
Figure 3-63 on page 3-58 is displayed on the right side.

Enable [] or disable [ ] the following alarms:

• Low-Low Alarm, Low Alarm, High Alarm and/or High-High Alarm for the sensor
temperature

• Cable Open Alarm and/or Cable Short Alarm for the Hydran sensor
• Replace Sensor Soon Alarm and/or Replace Sensor Now Alarm for the Hydran sensor

Figure 3-63 - System Fault Triggers
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• Low-Low Alarm and/or Low Alarm for the battery
• Low-Low Alarm, Low Alarm, High Alarm and/or High-High Alarm for the base

plate temperature

Click Apply to save the settings.

3.4.2.2.6 Water-Oil Condensation Temperature Alarm

In Figure 3-51 on page 3-46, click Water-Oil Condensation Temperature, and the menu
shown in Figure 3-64 on page 3-59 is displayed on the right side.

The following parameters can be adjusted:

• Alarm Delay, in minutes.
• Alarm Deadband, in °C.
• Enable [] or disable [ ] the Low Alarm Set Point by clicking the checkbox. Once an

alarm is enabled, a check mark appears in the box and the Set Point becomes enabled.
• If the Low Alarm Set Point is enabled, set its values in °C.
• If required, assign an Alarm Low Relay to the Low Alarm Set Point.
• Click Apply to save the settings.

Figure 3-64 - Water-Oil Condensation Temperature Alarm
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3.4.2.2.7 Analog User Defined Alarms

Note: These settings are only available when one or more inputs are set to Analog User
Defined.

In Figure 3-51 on page 3-46, click Analog User Defined #X, and the menu shown in
Figure 3-65 on page 3-60 is displayed on the right side.

The following parameters can be adjusted:

• Alarm Delay, in minutes.
• Alarm Deadband, in %.
• Enable [] or disable [ ] the Low-Low Alarm Set Point, Low Alarm Set Point, High

Alarm Set Point and/or High-High Alarm Set Point by clicking the appropriate

Figure 3-65 - Analog User Defined Alarms
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checkbox. Once an alarm is enabled, a check mark appears in the box and the Set Point
becomes enabled.

• If the Low-Low Alarm Set Point, Low Alarm Set Point, High Alarm Set Point or
High-High Alarm Set Point is enabled, set their values in amperes.

• Enable [] or disable [ ] the Input Fault Alarm by clicking the appropriate checkbox.
Once this alarm is enabled, a check mark appears in the box.

• If required, assign an Alarm Low-Low Relay to the Low-Low Alarm Set Point.
• If required, assign an Alarm Low Relay to the Low Alarm Set Point.
• If required, assign an Alarm High Relay to the High Alarm Set Point.
• If required, assign an Alarm High-High Relay to the High-High Alarm Set Point.
• Click Apply to save the settings.

3.4.2.3 Models

In the Hydran M2, the models are dynamic and are enabled depending on the Input Plugins
connected to the Hydran M2. If no additional Input Plugins are connected, only the Hydran
and moisture readings models are enabled. If Analog or Digital User Defined Inputs are set
in Input-Output Setup (Figure 3-46 on page 3-43), these can be configured in the models
also. For other standard models available in the Hydran M2, see Chapter 6 to Chapter 14.

3.4.2.3.1 Hydran Reading Setup

In Figure 3-42 on page 3-40, click the + to the left of Models, and then Hydran Reading
Setup. The menu shown in Figure 3-66 on page 3-61 is displayed on the right side.

The following parameters can be adjusted:

• Hourly Trend Period, in hours (the default value is 24 hours).
• Daily Trend Period, in days (the default value is 30 days).
• PPM Period B, in hours (the default value is 24 hours).

Figure 3-66 - Hydran Reading Setup
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• Click Apply to save the settings.

3.4.2.3.2 Moisture Reading Setup

In Figure 3-42 on page 3-40, click the + to the left of Models, and then Moisture Reading
Setup. The menu shown in Figure 3-67 on page 3-62 is displayed on the right side.

The following parameters can be adjusted:

• %RH Average Period, in hours (the default value is 24 hours).
• Type of Oil, selected using the drop-down list.
• Standard Temperature for RH, in °C: This value is used to convert the measured

relative saturation (RH%) to a relative saturation at a reference temperature. This
reference temperature can be configured from 0 to 40 °C with a default value of 20 °C.

• Click Apply to save the settings.

3.4.2.3.3 Analog User Defined Reading Setup

Note: These settings are only available when one or more inputs are set to Analog User
Defined.

In Figure 3-42 on page 3-40, click the + to the left of Models, and then Analog User
Defined #X. The menu shown in Figure 3-68 on page 3-63 is displayed on the right side.

The following parameters can be adjusted:

• Change the Input Name if desired.
• Change the Input Short Name if desired.
• Change the Input Units if required.

Figure 3-67 - Moisture Reading Setup
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• Set the Reading Precision to the number of decimals desired, selected using the drop-
down list.

• Click Apply to save the settings.

3.4.2.3.4 Digital User Defined Reading Setup

Note: These settings are only available when there is a digital input set to Digital User
Defined.

In Figure 3-42 on page 3-40, click the + to the left of Models, and then Digital User
Defined #X. The menu shown in Figure 3-69 on page 3-63 is displayed on the right side.

The following parameters can be adjusted:

• Change the Input Name if desired.
• Change the Input Short Name if desired.
• Change the Message Normal State if desired.

Figure 3-68 - Analog User Defined Reading Setup

Figure 3-69 - Digital User Defined Reading Setup
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• Change the Message Non-Normal State if desired.
• Click Apply to save the settings.

3.4.2.4 Sensor Temperature Setup

The Hydran sensor must be kept at a certain temperature in order to be accurate. The sensor
temperature is set in the Temperature Setup menu.

In Figure 3-42 on page 3-40, click Temperature Setup, and the menu shown in
Figure 3-70 on page 3-64 is displayed on the right side.

The following parameters can be adjusted:

• Set Point, in °C (the default value is 35 °C).
• Set Point Modulation, in °C (the default value is 10 °C).
• Modulation Period, in minutes (the default value is 120 minutes).
• Click Apply to save the settings.

3.4.2.5 History

The Hydran M2 acquires data regularly and stores it in its memory. This data is called
history and can be downloaded to a PC or simply deleted. The log rate can also be modified.

Note: The different history types are explained in more detail in Section 3.3.4 on page 3-24.

3.4.2.5.1 Clear History

In Figure 3-42 on page 3-40, click the + to the left of History, and then Clear History. The
menu shown in Figure 3-71 on page 3-65 is displayed on the right side.

Figure 3-70 - Sensor Temperature Setup
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• Click the appropriate checkbox to enable [] or disable [ ] the clearing of the following
history types:
– Alarm  
– Digital Event  
– Event  
– Short Term  
– Long Term  

• Click Apply to clear the selected history types.

Before deleting, the Histories Not Downloaded message box shown in Figure 3-72 on
page 3-65 is displayed.

• No: To delete the selected history types without first downloading them on the PC.
• Yes: To download the selected history types before deleting them.

After the deletion operation, the History Cleared message box shown in Figure 3-73 on
page 3-66 appears. Click OK.

Figure 3-71 - Clear History

Figure 3-72 - Histories Not Downloaded Message Box
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3.4.2.5.2 History Log Rate

The History Log Rate menu is used to set the sampling frequency of short-term and long-
term data acquisition.

In Figure 3-42 on page 3-40, click the + to the left of History, and then History Log Rate.
The menu shown in Figure 3-74 on page 3-66 is displayed on the right side.

The following parameters can be adjusted:

• Set the Short Term Rate, in minutes.
• Set the time of the day for the Long Term #1 data acquisition.
• Enable [] or disable [ ] the Long Term #2, Long Term #3 and/or Long Term #4 by

clicking the appropriate checkbox. Once a rate is enabled, the Hydran M2 acquires data
every day at this time.

• If the Long Term #2, Long Term #3 and/or Long Term #4 is enabled, set their time of
the day.

Figure 3-73 - History Cleared Message Box

Figure 3-74 - History Log Rate
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• Click Apply to save the settings.

3.4.2.6 Date and Time

This option is used to set the date and time of the Hydran M2.

In Figure 3-42 on page 3-40, click Date and Time, and the menu shown in Figure 3-75 on
page 3-67 is displayed on the right side.

The following parameters can be adjusted:

• Set the System Date by typing it directly or using the arrow.
• Set the System Time by typing it directly or using the arrows.
• Click Apply to save the settings.

3.4.2.7 Idle Menu

The Idle Menu is used to choose which panels will appear on the Hydran M2 display when
it is idle. If more than one is chosen, they will alternate every ten seconds. If none is
selected, the Hydran M2 will display the Main Menu.

Two panels are always available to be enabled [] or disabled [ ]:

• Hydran
• Moisture/Bubbling

The 11 other panels are available to be enabled [] or disabled [ ] if the corresponding
input(s) are configured:

• Winding Hot Spot H
• Winding Hot Spot X/C
• Winding Hot Spot Y

Figure 3-75 - Date and Time
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• Apparent Power H
• Apparent Power X
• Apparent Power Y
• Top Oil
• Aging
• Cooling Efficiency
• OLTC Temperature
• Tap Position

In Figure 3-42 on page 3-40, click Idle Menu, and a menu similar to the one shown in
Figure 3-76 on page 3-68 is displayed on the right side.

• Click the appropriate checkbox to enable [] or disable [ ] the display of each panel.
• Click Apply to save the settings.

3.4.3 Test

The Test function is used to verify the relays, alarms and Hydran sensor of the
Hydran M2. In the Configuration menu select Test, or click the button shown on
the right. The Test window shown in Figure 3-77 on page 3-69 appears.

• The left side displays the Test tree structure.
• To expand a node, click the + on its left.
• To collapse a node, click the - on its left.
• To see (on the right side) the parameters of an item, select its name on the left side.
• To apply the modifications brought to parameters, click Apply.
• To exit this box without applying the modifications, click Cancel or the X in the top right

corner.

Figure 3-76 - Typical Idle Menu
3-68 Rev. 6, December 2010 Part 17659



Configuration Menu
The expanded Test tree structure is shown in Figure 3-78 on page 3-69.

Note: To modify any parameters in the Test menu, a Level-2 password is required. Refer to
Section 2.2 on page 2-3.

Figure 3-77 - Test Window

Figure 3-78 - Expanded Test Tree
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3.4.3.1 Relay

The Relay menu is used to test the functionality of the Hydran M2 relays. There are five
relays in the Hydran M2, one reserved for device maintenance, and four for other uses.

In Figure 3-78 on page 3-69, click Relay, and the menu shown in Figure 3-79 on page 3-70
is displayed on the right side.

• Set each of the SysOK and Alarm 1 to Alarm 4 relays to one of the following modes:
– Force On: To turn it on for test purposes.
– Force Off: To turn it off for test purposes.
– Normal: For normal operation.

• Click Apply to save the settings.

3.4.3.2 Hydran Sensor

To test the Hydran sensor, click Hydran Sensor in Figure 3-78 on page 3-69. The menu
shown in Figure 3-80 on page 3-71 is displayed on the right side.

• Click Test.
• Wait until Stabilisation Delay becomes 0.
• The Sensor Test Result is indicated.
• More detailed results can be viewed in the Service menu (see Section 3.4.4.4.1 on

page 3-77).

Figure 3-79 - Relay Test Menu
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3.4.4 Service

The Service function is used to set the sensor parameters, to activate models, and
to view service data. In the Configuration menu select Service, or click the button
shown on the right. The Service window shown in Figure 3-81 on page 3-72
appears.

• The left side displays the Service tree structure.
• To expand a node, click the + on its left.
• To collapse a node, click the - on its left.
• To see (on the right side) the parameters of an item, select its name on the left side.
• To apply the modifications brought to parameters, click Apply.
• To exit this box without applying the modifications, click Cancel or the X in the top right

corner.

Figure 3-80 - Hydran Sensor Test Menu
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Figure 3-81 - Service Window
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The expanded Service tree structure is shown in Figure 3-82 on page 3-73.

3.4.4.1 HM2 Sensor Param

This option is used to set the parameters of the Hydran and moisture sensors.

In Figure 3-82 on page 3-73, click HM2 Sensor Param, and the menu shown in
Figure 3-83 on page 3-74 is displayed on the right side.

• The following parameters can be adjusted:
– Sensor serial number
– Hydran sensor:

- Value of the parameters B, M, N, S and A1 to A6
- Value of the parameters checksum

– Moisture sensor:
- Value of the parameters C1 to C10
- Value of the parameters checksum

• Click Apply to save the settings.

Figure 3-82 - Expanded Service Tree
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Figure 3-83 - HM2 Sensor Param
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If an erroneous parameter is entered, the Incorrect Parameters message box shown in
Figure 3-84 on page 3-75 appears.

• Click OK.
• Enter valid parameters.

Once valid parameters are entered, the Sensor Successfully Installed message box shown
in Figure 3-85 on page 3-75 is displayed. Click OK.

3.4.4.2 Engineering

In Figure 3-82 on page 3-73, click Engineering, and the menu shown in Figure 3-86 on
page 3-76 is displayed on the right side.

• Hydran Engineering Slope: Slope for the Hydran sensor
• Hydran Engineering Offset: Offset for the Hydran sensor, in ppm
• %RH Engineering Slope: Slope for the moisture sensor
• %RH Engineering Offset: Offset for the moisture sensor, in %

Figure 3-84 - Incorrect Parameters Message Box

Figure 3-85 - Sensor Successfully Installed Message Box
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• To verify the range of a value to enter, place the mouse cursor over the input window. A
yellow box appears displaying the minimum and maximum of the input range (see
Figure 3-87 on page 3-76).

• If an entered value is outside the range limits, an error message box appears (see an
example in Figure 3-88 on page 3-76).

• Click Apply to save the settings.

3.4.4.3 Models Activation

In Figure 3-82 on page 3-73, click Models Activation, and the menu shown in Figure 3-89
on page 3-77 is displayed on the right side.

Figure 3-86 - Engineering Menu

Figure 3-87 - Range Indicator

Figure 3-88 - Typical Out-of-Range Error Message Box
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• To activate the models, type the Models Activation Key.
• Click Apply to save the settings.
• To check if the models were activated, close the Models Activation menu and open it

again. The Models Activation Status should indicate Enabled.

3.4.4.4 View Service Data

The View Service Data menu presents:

• Information about the Hydran M2 which has been collected during the tests performed
• Other system information

3.4.4.4.1 Hydran Service Data

In Figure 3-82 on page 3-73, click the + to the left of View Service Data, and then Hydran
Service Data. The data shown in Figure 3-90 on page 3-77 is displayed on the right side.

Figure 3-89 - Models Activation Menu

Figure 3-90 - Hydran Service Data
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The following service data is displayed for the Hydran sensor:

• Service U, in ppm
• Service V, in microvolts
• Service F and Service L, in millivolts
• Service A, Service I and Service R  

3.4.4.4.2 %RH Service Data

In Figure 3-82 on page 3-73, click the + to the left of View Service Data, and then %RH
Service Data. The data shown in Figure 3-91 on page 3-78 is displayed on the right side.

The value of Service V (in microvolts) is displayed for the moisture sensor.

3.4.4.4.3 Configuration Version Tracking

The Configuration Version Tracking records the number of setting changes done to the
Hydran M2. Every time a setting is modified, the number increases by 0.001.

In Figure 3-82 on page 3-73, click the + to the left of View Service Data, and then Config-
uration Version Tracking. The menu shown in Figure 3-92 on page 3-78 is displayed on
the right side.

• If required, reset the count by typing 0.
• If required, input a number to set the integer part. For example, 2 will be interpreted as

2.000.
• Click Apply to save the settings.

Figure 3-91 - %RH Service Data

Figure 3-92 - Configuration Version Tracking Menu
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3.4.4.4.4 System Information

The System Information menu displays the serial numbers of the system, the controller
board and the plugin input-output cards.

In Figure 3-82 on page 3-73, click the + to the left of View Service Data, and then System
Information. The menu shown in Figure 3-93 on page 3-79 is displayed on the right side.

• A Level-3 password (see Section 2.2 on page 2-3) is required to modify the System
Serial Number.

• The following information is displayed:
– Software version and serial number of the controller
– Type and serial number of the plugin sites No. 1 to No. 4
– Type and serial number of the communication plugin sites No. 1 and No. 2

• Click Apply to save the settings.

Figure 3-93 - System Information Menu
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3.4.4.4.5 Sensor Information

In Figure 3-82 on page 3-73, click the + to the left of View Service Data, and then Sensor
Information. The menu shown in Figure 3-94 on page 3-80 appears on the right side.

The following information on the Hydran M2 sensor card is displayed:

• Type
• Serial number
• Status
• Software version

3.4.4.5 Device Language

This option is used to change the language of the Hydran M2’s embedded software, as well
as the date format, the date separator and the decimal separator as seen in the embedded
software.

In Figure 3-82 on page 3-73, click Device Language, and the menu shown in Figure 3-95
on page 3-81 appears.

• The following parameters can be adjusted:
– Device Language: choose between Russian and English.
– Date Format: select between YYYY-MM-DD and DD-MM-YYYY.
– Date Separator: select between Slash (/), Dash (-), Point (.) and Space ( ).
– Decimal Separator: select between Point (.) and Comma (,).

• Click Apply to save the settings.

Figure 3-94 - Sensor Information Menu
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3.4.5 Display Settings

The Display Settings box is used to customize the acronyms used throughout the
Hydran M2 Host (DNP) software application as well as the upper and lower limits used in
the graphical display.

In the Configuration menu select Display Settings, and the Display Settings box shown
in Figure 3-96 on page 3-81 appears.

• Click the Down arrow to select a parameter in the Description drop-down list.
• Modify the Acronym, Display Minimum and/or Display Maximum if desired.
• To apply the modifications brought, click Apply.

Figure 3-95 - Device Language Menu

Figure 3-96 - Display Settings Box
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• To exit this box without applying the modifications, click Cancel or the X in the top right
corner.

3.5 OPTIONS MENU

The Options menu includes four items:

• Change Working Mode (Section 2.4.2 on page 2-13)
• Security (Section 2.2 on page 2-3)
• Connection (Section 2.4.2 on page 2-13)
• Embedded Version (Section 3.5.1 on page 3-82)

3.5.1 Embedded Version

This function is used to know the number of the Hydran M2’s embedded version.

In the Options menu select Embedded Version, and the Embedded Version box shown
in Figure 3-97 on page 3-82 is displayed. Click OK.

3.6 HELP

The software version information as well as the General Electric Canada coordinates are
available in the About box.

In the Help menu select About, and the About box shown in Figure 3-98 on page 3-83 is
displayed.

Figure 3-97 - Embedded Version Box
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• The following information is presented:
– The version number of the Hydran M2 Host (DNP) software, the controller and the

sensor.
– The coordinates of General Electric Canada.

• Click System Info... to view the local computer properties.
• Click OK to close the box.

Figure 3-98 - About Box
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PAGE LEFT INTENTIONALLY BLANK
3-84 Rev. 6, December 2010 Part 17659



Chapter 4

Model Inputs and Selection

In order to obtain valuable information about the real-time operating conditions of the
transformer, the Hydran M2 uses many different monitoring models, each one defined as a
specific computation or algorithm, and following industry-recognized standards (such as
the IEEE and IEC Loading Guides).

Each model uses the data received from the sensors connected to the transformer, and
makes computations to produce useful transformer information. The model gives results
that can be compared with user-configurable alarm levels.

This Chapter explains how to select one of the various models.

4.1 INPUTS REQUIRED FOR EACH MODEL

The Hydran M2 is limited to four plugin ports for 4–20 mA or digital inputs. Thus, at any
given time, the total number of models that can run simultaneously on the Hydran M2 is
limited, based on the four configured inputs. Since the digital input card is dual, two of the
digital inputs can be configured on one card.

Table 4-1 on page 4-2 depicts the inputs required or optional to enable a model.

The first three inputs (Hydran Gas Level, Relative Humidity, and Sensor Temperature) are
included as part of the functionality of the Hydran M2; therefore they do not need to be
assigned to any of the four available plugin ports. Of the 11 remaining analog and digital
inputs, up to four can be configured to enable models.

For example, assume the following inputs are selected:

• Top Oil Temperature using a 4–20 mA plugin card in input slot No. 1
• Load Current Winding H using a 4–20 mA plugin card in input slot No. 2
• Ambient Temperature using a 4–20 mA plugin card in input slot No. 3
• Status of Cooling Bank #1 and Status of Cooling Bank #2 using a digital input card in

plugin slot No. 4
Part 17659 Rev. 6, December 2010 4-1



Chapter 4 • Model Inputs and Selection
Table 4-1 - Inputs Required for Each Model

Required and Optional Inputs Analog Digital
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Transformer Insulation Models:

Winding H Apparent Power R

Winding X Apparent Power R

Winding Y Apparent Power R

Winding H Hot-Spot Temperature R R

Winding X Hot-Spot Temperature R R

Winding Y Hot-Spot Temperature R R

Insulation Aging R R R R

Moisture and Bubbling R R R R

Moisture Content in Insulating Barrier R R R R R O O

Cooling System Models:

Cooling Efficiency R R R R R O

Cooling Banks Status R R

Tap Changer Models:

OLTC Position Tracking R

OLTC Temperature Differential R R
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This input selection would enable the following models:

• Winding H Apparent Power
• Winding H Hot-Spot Temperature
• Insulation Aging
• Moisture and Bubbling
• Moisture Content in Insulating Barrier
• Cooling Efficiency
• Cooling Banks Status

4.1.1 Assigning Inputs

The models are dynamically enabled based on the inputs configured. For instance, in order
for the Winding Hot-Spot Temperature model to be enabled, the user must navigate to the
Setup tree (Figure 3-42 on page 3-40), click Input-Output Setup, and assign Top Oil
Temp and a Winding Current to inputs. Once these are assigned, the Hydran M2
dynamically enables the Winding Hot-Spot Temperature model. The user may then click
Models in the Setup tree to configure the model in question.

The inputs to activate the models can be selected from a predefined list during input config-
uration. The list of analog inputs includes:

• Top Oil Temp  
• OLTC Tank Temp  
• Tap position  
• Winding H Current  
• Winding Y Current  
• Winding X Current  
• Ambient Temp  
• Bottom Oil Temp  
• User defined  

The list of digital inputs includes:

• Cooling Bank 1  
• Cooling Bank 2  
• Trans. Energized  
• User Defined  
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4.1.2 Input Alarms

The inputs Top Oil Temp, Bottom Oil Temp and Ambient Temp all have input fault
alarms that can be enabled or disabled. A lost input connection will produce N/A values for
the inputs as well as the corresponding models, thus the input fault alarms will alert the user
that the input signal is unavailable.

4.2 MODEL SELECTION

In the View menu select Models, or click the button shown on the right. The View
Models window shown in Figure 4-1 on page 4-4 appears.

Figure 4-1 - View Models Window With Real-Time Values
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4.2.1 Real Time Values

By default, Real Time Values is selected in Figure 4-1 on page 4-4. To display a model’s
real-time graph that is updated every 15 seconds, proceed as follows:

• Ensure Real Time Values is selected.
• Click the name of one of the available real-time models on the left side.
• If Custom Screen is selected, see Section 3.3.3.1.1 on page 3-19.
• To close the window without generating a real-time graph, click Cancel or the X in the

top right corner.

Note: The commands available for all graphs are described in Chapter 5.

For detailed explanation of the models, the required inputs, the models outputs and the
associated alarms, see Chapter 6 to Chapter 14.

4.2.2 Historic Values

When the Historic Values mode is selected, the displayed readings and models are different
from the ones available in real time. This feature is used to see all related historic records,
even if the selected inputs are no longer connected.

In the View Models window (Figure 4-1 on page 4-4), click Historic Values, and this
window becomes as shown in Figure 4-2 on page 4-6.

The Time Stamp and the Start Date are now enabled. Also, all the models now appear on
the left side, to allow graphing historic values if they exist.

• Ensure Historic Values is selected.
• To display the historic values since a certain day, click Day and select the Start Date.

This will graph the selected model’s values from that day to the last available entry.
• To display the historic values since the beginning of a certain month, click Month and

select the Start Date. This will graph the selected model’s values from the beginning of
that month to the last available entry.

• To display the historic values during a certain period, click Range and select the Start
Date and then the End Date. This will graph the selected model’s values between the
two dates.

• Click the name of the desired model on the left side.
• If Custom Screen is selected, see Section 3.3.3.1.1 on page 3-19.
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• To close the window without generating a real-time graph, click Cancel or the X in the
top right corner.

Note: The commands available for all graphs are described in Chapter 5.

If no History is available for the desired period of time, the History not available message
box shown in Figure 3-24 on page 3-24 appears. Click OK, and modify the Time Stamp,
the Start Date and/or the End Date in Figure 4-2 on page 4-6.

For detailed explanation of the models, the required inputs, the models outputs and the
associated alarms, see Chapter 6 to Chapter 14.

Figure 4-2 - View Models Window With Historic Values
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Chapter 5

Commands Common to All Model Windows and Graphs

The commands described in this Chapter apply to most monitoring models (from Chapter 6
to Chapter 14), and to all the graphs generated by the Hydran M2 Host (DNP) software.
The graph area of a typical model window is shown in Figure 5-1 on page 5-1.

Figure 5-1 - Typical Graph Area
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5.1 ANALOG SIGNAL DISPLAYS

In most windows and graphs, an analog signal display is represented as in Figure 5-2 on
page 5-2.

The following properties apply to all analog signal displays:

• The colored line under the name is given by the Hydran M2 Host (DNP) software and is
the color of the curve for that signal (refer to Figure 5-1 on page 5-1).

• The value (35.1 in Figure 5-2 on page 5-2) and the needle indicate the reading for that
signal at the present moment.

• The limits for the scale (-50 and 210 °C in this case) are the maximum and minimum
displayed values. To modify them, refer to Section 3.4.5 on page 3-81.

• The colors green, yellow and red are delineated by the alarm set-points (85 and 95 °C in
this case).

• These three colors for the different alarm levels cannot be modified.

5.2 DIGITAL SIGNAL DISPLAYS

In most windows and graphs, a digital signal display is represented as in Figure 5-3 on
page 5-2.

Figure 5-2 - Analog Signal Display

Figure 5-3 - Digital Signal Display
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Vertical Scales for Analog Signals
The following properties apply to all digital signal displays:

• The colored line under the name is given by the Hydran M2 Host (DNP) software and is
the color of the graph for that signal.

• The value (Off in this case) indicates the status of that signal at the present moment.
• The sensor is always shown with a green circle, no matter if it is On or Off.

5.3 VERTICAL SCALES FOR ANALOG SIGNALS

A window or a graph can possess a maximum of ten vertical scales, including digital inputs
(refer to Figure 5-1 on page 5-1). The following properties apply to the vertical scales for
analog model values:

• The number of vertical scales is equivalent to the number of signals displayed (one scale
per signal).

• The color of the vertical scale is given by the Hydran M2 Host (DNP) software, and it is
the same as the corresponding curve.

• The limits for a vertical scale (-50 and 210 °C for the last scale on the right side in
Figure 5-1 on page 5-1) are the same as in the corresponding display above the chart, and
they are the maximum and minimum displayed values. To modify them, refer to
Section 3.4.5 on page 3-81.

• There is a maximum of five vertical scales the left side of the chart and a maximum of
five vertical scales on the right side.

• Above the chart (on top of Figure 5-1 on page 5-1), each of the small squares represents
a curve. For each signal displayed, the corresponding square contains a button with the
same color as the curve.

• Click one of the small squares to depress it and the corresponding curve and vertical scale
disappear from the chart (however, the corresponding display above the chart remains
visible). When doing so, the vertical scales for the other curves remain on their respective
side. Click a small square to press it and the corresponding curve and vertical scale
reappear.

• The vertical scale of any curve can be extended by clicking it and dragging it down, in
order to improve the clarity of the corresponding curve. To return a vertical scale to its
initial condition, click it and drag it up many times until there is no movement.
Part 17659 Rev. 6, December 2010 5-3



Chapter 5 • Commands Common to All Model Windows and Graphs
5.4 VERTICAL SCALES FOR DIGITAL SIGNALS

Digital inputs can have an On or Off state only. The following properties apply to the
vertical scales for digital model values:

• All digital input curves use the same vertical scale labeled Digital Inputs. The even
values on that scale represent the Off state and the odd values on the scale represent the
On state.

• The color of the vertical scale is given by the Hydran M2 Host (DNP) software, and it is
the same as the corresponding curve.

• The limits for the vertical digital scale are 0 and 14.
• Above the chart, each of the small squares represents a curve. For each signal displayed,

the corresponding square contains a button with the same color as the curve.
• Click one of the small squares to depress it and the corresponding curve disappears from

the chart (however, the corresponding display above the chart remains visible). When
doing so, the vertical scales for the other curves remain on their respective side. Click a
small square to press it and the corresponding curve reappears.

5.5 HORIZONTAL SCALE

There is one horizontal time scale per graph, whatever the number of signals displayed (see
Figure 5-1 on page 5-1). The following properties apply to the horizontal scale in all
graphs:

• If Real Time Values has been selected in Figure 3-18 on page 3-18, the horizontal scale
extends from the time of the graph creation until now.

• If Historic Values has been selected in Figure 3-18 on page 3-18, the horizontal scale
covers the period of time selected.

• In the main window for a particular monitoring model, the horizontal scale covers the
period of time selected in Figure 4-2 on page 4-6.

• A horizontal scale can be extended by clicking it and dragging it to the left or to the right,
in order to improve the clarity of all curves.

• When the horizontal scale is modified, all curves vary correspondingly. However,
extending the scale beyond the initial start date does not allow to display older values.

• To return the horizontal scale to its initial condition, click it and drag it to the left or to
the right many times until the curves touch the left axis of the chart. You can also
regenerate the graph.
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Zoom
5.6 ZOOM

In addition to modifying the vertical and/or horizontal scales in a chart, the clarity of the
various curves can also be improved by using the zoom function.

To do so, move the cursor into the graph and click the left button of the mouse. Drag the
cursor to the opposite corner of a box with the desired dimensions, and let go the left button
of the mouse. The selected zoom area expands to cover the entire graph, and all curves and
scales are modified accordingly. However, the displays above the chart do not change. This
process can be repeated until a certain section of the graph is shown as desired.

To zoom out, move the cursor into the graph and click the right button of the mouse, as
many times as wanted. To return a graph to its initial condition, click the right button of the
mouse until both ends of the curves can be seen, and then draw a zoom box around the
curves to zoom in; you can also regenerate the graph.

Note: If you return a graph to its initial condition by zooming out, the range of the vertical
and horizontal scales will probably vary slightly from those in the initial window.
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Chapter 6

Apparent Power Model

The primary function of this model is to continuously monitor the load carried by the
transformer in MVA (Mega Volt-Amperes). The Apparent Power can be computed on the
primary, secondary, and tertiary windings, depending on the input configuration. The
historic maximum MVA value is retained with a time stamp and can be reset by the user.

The current signal is a mandatory input, whereas the voltage signal is configured as a fixed
value. Since voltage variations occurring in service and tap changer operations are not
taken into consideration, the MVA is an approximate reading, and used only for display
purposes.

The sensors, rules and outputs of the Apparent Power model are illustrated in Figure 6-1 on
page 6-1.

6.1 MODEL INPUTS

• H winding current (required)
• X winding current (optional)

Figure 6-1 - Summary of the Apparent Power Model
Part 17659 Rev. 6, December 2010 6-1



Chapter 6 • Apparent Power Model
• Y winding current (optional)

6.2 PARAMETERS TO CONFIGURE

Number of Phases:

• Enter 1 phase for single-phase transformers.
• Enter 3 phases for three-phase transformers.

Rated Current on Windings H, X, Y and C: The rated load current for each winding is
expressed in amperes (A) and is configurable from 1 to 5,000 A for the H winding, and
from 1 to 50,000 A for the X and Y windings. The C winding is applicable only for
autotransformers; it is configurable from 1 to 50,000 A. Before configuration, a default
value of 250 A is shown for all current values.

Rated Voltage on High Voltage Side, Rated Voltage on Low Voltage Side (optional) and
Rated Voltage on Tertiary Side (optional): The rated voltage for each winding can be
derived from the transformer nameplate. For three-phase transformers, the value written for
the line-to-line voltage is required. For single-phase transformers, the value written for line-
to-ground voltage is required for star windings, and the value written for line-to-line
voltage is required for delta windings. These voltages are expressed in kilovolts (kV). The
rated voltage is configurable from 10 to 1,500 kV for the H and X windings, and from 3 to
1,500 kV for the Y winding. Before configuration, a default value of 100 kV is shown.

6.3 MODEL OUTPUTS

Winding H MVA: The historic maximum load value on the H winding with a time stamp.
The load is expressed in Per Unit (p.u.) of rated current. This value is resettable by the user.

Winding X MVA and Winding Y MVA (if the X winding current and the Y winding current
are configured as inputs): The historic maximum load values on the X and Y windings with
time stamps. The loads are expressed in Per Unit (p.u.) of rated current. These values are
resettable by the user.

6.4 MAIN WINDOW

The main window for the Apparent Power model is shown in Figure 6-2 on page 6-3. The
commands applying to all monitoring models are explained in Chapter 5.
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Main Window
By default, the following ten analog signals are displayed:

• Current winding H (minute-averaged value of the load current for phase H)
• Current winding X (minute-averaged value of the load current for phase X)
• Current winding Y (minute-averaged value of the load current for phase Y)
• Rated Voltage on HV side
• Rated Voltage on LV side
• Rated Voltage on Tertiary side
• Apparent Power from H winding
• Apparent Power from X winding
• Apparent Power from Y winding
• Per Unit load on most loaded winding

Figure 6-2 - Main Window for the Apparent Power Model
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Note: If only one winding current is set as input, the Apparent Power model is still enabled,
but only computes the parameters related to that winding as well as the Per Unit load on
the most loaded winding.
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Chapter 7

Winding Hot-Spot Temperature Model

The rating of a transformer is closely linked to the winding temperature as it governs the
insulation aging rate and bubbling release threshold. This winding temperature can also
raise an alarm if excessively high values occur. In the industry standards, the winding
temperature limit is defined as a temperature rise above the ambient air temperature. The
cooling system is designed to ensure that at full load, the average winding temperature rise
does not exceed the industry-accepted value (usually 65 °C).

However it is not the average winding temperature that is of most interest but rather the
temperature in the hottest area (so called “hot-spot temperature”). This temperature cannot
be measured directly as it is not possible to insert thermocouples in a winding that is to be
put in service. It is possible to use fiber optic temperature sensors that do not interfere with
dielectric strength but this procedure is costly and is usually limited to the validation of the
manufacturer calculation methods. Therefore the traditional method was to use a Winding
Temperature Indicator to fulfill that function.

A more accurate and reliable evaluation of the hot-spot temperature can be provided, using
the equations provided in IEEE and IEC Loading Guides:

• IEEE C57.91 - 1995, IEEE Guide for Loading Mineral-Oil-Immersed Transformers
• IEC 60076-7 - 2005, Power Transformers - Part 7: Loading Guide for Oil-Immersed

Power Transformers

In the computation methods described in these Loading Guides, a key value is the
temperature difference between the winding hot-spot and the top oil at rated conditions.
This value is normally provided by the transformer manufacturer after suitable validation
of their computation method. In the Winding Hot-Spot Temperature model, this rated value
is corrected to account for actual load current and winding thermal time constant. The
computed hot-spot temperature rise is then added to the measured top oil temperature to
provide the actual winding hottest-spot temperature.

The winding hot-spot temperature is computed separately for each winding. The highest
value of winding hot-spot temperature is identified and used to raise an alarm signal on the
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transformer. The hottest winding might not always be the same, depending on the load on
the tertiary winding and on the position of the tap changer.

For autotransformers, the winding hot-spot temperature is calculated for the series winding
(H), the common winding (C) and the tertiary winding (Y). The current in the common
winding is calculated by subtracting the secondary load current minus the primary load
current.

The sensors, rules and outputs of the Winding Hot-Spot Temperature model are illustrated
in Figure 7-1 on page 7-2.

7.1 MODEL INPUTS

• Top oil temperature
• H winding current (required)
• X winding current (optional)
• Y winding current (optional)

7.2 PARAMETERS TO CONFIGURE

Transformer Type: Select between Standard Transformer and Autotransformer, in order to
calculate correctly the load current in the common winding of autotransformers.

Rated Current on Winding H, Rated Current on Winding X (optional) and Rated Current
on Winding Y (optional): For each winding, the rated current on the top cooling mode is to

Figure 7-1 - Summary of the Winding Hot-Spot Temperature Model
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Model Outputs
be used. These values are available from the transformer nameplate. The rated load current
is expressed in amperes (A) and is configurable from 1 to 5,000 A for the H winding, and
from 1 to 50,000 A for the X and Y windings. Before configuration, a default value of
250 A is used.

Winding Exponent: The winding exponent “m” relates the hot-spot rise above top oil to the
load level. It is normally calculated only for the top cooling mode. It can be derived from
the temperature rise tests under several load levels. If no information is available, a default
value of 0.8 can be used for the ONAN, ONAF and OFAF cooling types, and a default value
of 1.0 can be used for the ODAF cooling type. This value is configurable between 0.5 and
1.0, and the system default value is 0.9.

Winding Time Constant: The winding has its own thermal capacity that will delay
somewhat the temperature change caused by load variations. This delay is significant only
during sudden overloads of high magnitude. Specific values can be obtained from the
manufacturer or by analysis of results from temperature rise tests. A default value of
6 minutes is conservative and acceptable in most cases. This value is configurable from 0.1
to 20 minutes and the system default value is 6 minutes.

Rated Hot-Spot Rise Above Top Oil in Winding H, Rated Hot-Spot Rise Above Top Oil in
Winding X (optional) and Rated Hot-Spot Rise Above Top Oil in Winding Y (optional): The
winding hottest-spot temperature rise above top oil is needed on the top cooling mode, at
rated load, for each winding to be monitored. On recent units, these values should appear
on the reports for temperature rise tests (heat run test). Otherwise they have to be obtained
from the manufacturer. These values are critical for winding hot-spot calculation and an
effort should be made to get the proper values. As a last resort, an approximate value can
be obtained from calculations as recommended in the IEC and IEEE Loading Guides. This
value is configurable from 1 to 50 °C and the system default value is 30 °C.

Rated Hot-Spot Rise Above Top Oil in Winding C (optional): Winding C is applicable only
for autotransformers. For this type of unit, the H winding is considered as the series
winding and the current in the common winding is calculated by subtracting the LV current
minus the HV current. The winding hot-spot rise is similar as for a regular transformer.

7.3 MODEL OUTPUTS

Winding Hot-Spot Temperature in Winding H
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Winding Hot-Spot Temperature in Winding X and Winding Hot-Spot Temperature in
Winding Y (if load current X and load current Y are configured as inputs).

Winding Hot-Spot Temperature in Winding C (if load current C is configured as an input
and Transformer type is Autotransformer).

Highest Winding Hot-Spot Temperature

Historic Maximum Value of Winding H Hot-Spot Temperature, Historic Maximum Value
of Winding X Hot-Spot Temperature, Historic Maximum Value of Winding Y Hot-Spot
Temperature and Historic Maximum Value of Winding C Hot-Spot Temperature with time
stamps: These values are resettable by the user.

7.4 ASSOCIATED ALARMS

Top Oil Temperature Hi and Hi-Hi Alarms: These values are configurable from 50 to
200 °C. The system default values are 85 °C for the Hi alarm and 95 °C for the Hi-Hi alarm.
These alarms come with a deadband configurable from 0 to 15 °C (default: 2 °C) to avoid
oscillation of the alarm signal. A time delay, configurable from 0 to 30 minutes (default:
1 minute), is also provided for the same purpose.

Winding Hot Spot Hi and Hi-Hi Alarms: These alarms are sensitive to all windings being
monitored and react to the hottest winding temperature. These values are configurable from
70 to 170 °C. The system default values are 110 °C for the Hi alarm (this is the rated
temperature for thermally-upgraded paper) and 120 °C for the Hi-Hi alarm. These alarms
come with a deadband configurable from 0 to 15 °C (default: 2 °C) to avoid oscillation of
the alarm signal. A time delay, configurable from 0 to 30 minutes (default: 1 minute), is
also provided for the same purpose.

Note: Appendix B presents the list of all alarm messages that can appear on the Hydran M2
Host (DNP) software.

7.5 MAIN WINDOW

The main window for the Winding Hot-Spot Temperature model is shown in Figure 7-2 on
page 7-5. The commands applying to all monitoring models are explained in Chapter 5.
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Main Window
By default, the following eight analog signals are displayed:

• Top Oil Temperature
• Current Winding H
• Current Winding X
• Current Winding Y
• Winding Hot-Spot Temperature in winding H
• Winding Hot-Spot Temperature in winding X
• Winding Hot-Spot Temperature in winding Y
• Highest Winding Hot-Spot Temperature

Note: If only one winding current is set as input, the Winding Hot-Spot Temperature model
is still enabled but only computes the parameters related to that winding as well as the Per
Unit load on the most loaded winding.

Figure 7-2 - Main Window for the Winding Hot-Spot Temperature Model
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Chapter 8

Insulation Aging Model

Winding insulation is made of oil-impregnated cellulose material. In order to properly
fulfill its function, this material needs to have a certain mechanical strength and flexibility.
These properties depend on the length of the cellulose chain constituent of the paper and
pressboard. With time and temperature, these long polymer chains break down into shorter
segments, a process called depolymerization. The practical effect is that the paper loses its
flexibility and tensile strength to become a brittle material. The winding is continuously
submitted to clamping forces and vibrations. Moreover, during short-circuit on the system,
these forces are increased tremendously and if the insulating paper is too brittle, it may
rupture under the pressure and create a weak point in the insulation that will later allow
flashover between adjacent turns when a voltage surge occurs on the transformer.

This insulation aging process is irreversible. It is also the main factor determining the trans-
former’s end of life. The rate of aging of cellulose insulation material is a function of the
following factors:

• Insulation temperature at the hot spot
• Water content in the winding insulation paper
• Oxygen content of the insulating oil

The effect of temperature is the most important, as described in the IEEE and IEC Loading
Guides. The effect of temperature on aging is a function of the type of paper. It is therefore
important to state in the configuration page the type of paper used for winding insulation.

A second factor affecting insulation aging is the moisture content. It is assumed that the
aging acceleration factor is directly proportional to the water content with 0.5 % as
reference value for dry paper. The water content in winding insulation is computed in the
Moisture Content in Insulating Barrier model (Chapter 10). The effect is more severe on
the normal Kraft paper than on thermally-upgraded paper and it can be practically neglected
on Aramid paper.

The third factor is the oxygen content of the insulating oil. This oxygen content can be
inferred from the type of oil preservation system. The IEEE Loading Guide recommends
using an aging acceleration factor of 2.5 for free-breathing conservators while the sealed-
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type transformers and those with a membrane in the conservator are practically oxygen-
free.

The sensors, rules and outputs of the Insulation Aging model are illustrated in Figure 8-1
on page 8-2.

8.1 MODEL INPUTS

• Top oil temperature
• H winding current (required)
• X winding current (optional)
• Y winding current (optional)

8.2 PARAMETERS TO CONFIGURE

Aging Calculation Method and Type of Paper: The selection of the paper type is tied
directly to the selection of the aging calculation method:

• Select IEC 65 °C rise for units built according to IEC rules with a 65 °C average
winding rise and a maximum rated winding hot-spot temperature of 98 °C.

• Select IEEE 55 °C rise for older units built according to IEEE rules with a 55 °C average
winding rise and a maximum rated winding hot-spot temperature of 95 °C.

Figure 8-1 - Summary of the Insulation Aging Model
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Parameters to Configure
• Select IEEE 65 °C rise as defined in the IEEE Loading Guide for transformers with a
65 °C average winding rise and a maximum rated winding hot-spot temperature of
110 °C.

• Select Nomex aging for winding insulation made of Aramid paper with a maximum
rated winding hot-spot temperature of 188 °C.

Some newly-built transformers are specified with a 55 °C average winding rise although
they use thermally-upgraded insulating paper that would allow the transformer to operate
at 65 °C for normal life duration. Selecting a lower-rated temperature rise provides longer
life duration in those applications where the ambient temperature is expected to be very
high. In such case, the type of paper should be configured as IEEE 65 °C rise.

Some transformers are specified according to IEC standard with the addition of thermally-
upgraded paper. In this case, the rated hot-spot temperature is 110 °C and the IEEE 65 °C
rise formula should be used for aging calculation.

Previous Aging: The previous aging can be configured when a monitoring system is
retrofitted on an existing transformer. When a monitoring system is installed on a
transformer that has been in service for some time, the user may wish to enter in the
cumulative aging counter the thermal aging incurred before commissioning of the
monitoring system. This aging must be estimated by the user from the loading history, the
ambient temperature, the estimated water content in the winding insulation, and the oxygen
content in the oil. When only subsequent aging is to be reported, a value of 0 hour in used
for this configuration field. The Previous Aging value is configurable from 0 to
400,000 days and the default value is 0 day.

Oil Preservation System: The type of oil preservation system has a direct influence on the
amount of oxygen dissolved in the transformer oil, thus determining the aging acceleration
factor used in the calculation of the Global Aging Acceleration factor. The aging acceler-
ation factor used by the Hydran M2 is as follows:

• 1 for a sealed tank or a conservator with membrane
• 2.5 for a free-breathing conservator

Previous Service Time: The Service Time represents the number of days the transformer
has been in service regardless of the load level, prior to the commissioning of the
monitoring system. When only subsequent aging is to be reported, a value of 0 hour should
be used for this configuration. This value is configurable from 0 to 40,000 days with a
default value of 0 day.
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8.3 MODEL OUTPUTS

Thermal Aging Acceleration Factor considering only the hot-spot current temperature.

Moisture Aging Acceleration Factor considering only the effect of moisture in paper.

Global Aging Acceleration Factor: This is the actual aging rate or aging acceleration factor,
considering the cumulated effect of temperature, moisture and oxygen in oil.

Cumulative Aging: This field indicates the aging cumulated since the commissioning of the
system, adding the “Previous Aging” if this value was configured on the Insulation Aging
Model configuration page. The value is expressed in days of operation at rated temperature;
for instance, a transformer with thermally-upgraded paper operating 24 hours at 117 °C
will undergo 2 days of “normal aging at rated temperature.”

Service Time: This field indicates the number of days the transformer has been in service
since the commissioning of the system, adding the “Previous Service Time” if this value
has been configured.

8.4 MAIN WINDOW

The main window for the Insulation Aging model is shown in Figure 8-2 on page 8-5. The
commands applying to all monitoring models are explained in Chapter 5.

By default, the following three analog signals are displayed:

• Highest winding hot-spot temperature
• Global aging accumulation factor
• Moisture content in winding paper
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Main Window
Figure 8-2 - Main Window for the Insulation Aging Model
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Chapter 9

Moisture and Bubbling

The moisture content of the oil and the solid insulation is a serious concern for power trans-
formers, especially for aging units. Extensive drying procedures are applied at the manufac-
turing stage and sustained efforts are deployed in service to maintain a high level of
dryness. However, with time, water can penetrate through various paths such as the air
breather and leaky gaskets. Aging of cellulose also releases some water. Moisture tends to
accumulate in the solid insulation and leads to several detrimental consequences, namely:

• Acceleration of insulation aging
• Risk of water vapor bubbles being released from the winding insulation
• Reductions of dielectric strength of insulating barriers
• Risk of water condensation in transformer oil at low temperatures

Moisture content assessment is too often derived from a single oil sample submitted to a
Karl Fischer test in laboratory. This is a valid approach for oil evaluation but it does not
allow evaluation of the moisture content in the solid insulation as the rate of water exchange
between the oil and the paper has to be taken into account. On-line monitoring of moisture
in oil allows integration of temperature variations and the computation of a dependable
value for moisture content in the various components of the solid insulation system, even
if they are at different temperatures and characterized by different diffusion rates.

The most critical part of the winding insulation is the top of the winding that operates at the
hot-spot temperature. This is the area where the aging is most severe, and the effect of the
water content can be computed. The determination of the critical temperature for bubble
evolution takes into account the atmospheric pressure, the oil pressure above the hot-spot
area, and the amount of gas dissolved in the oil.

The moisture sensor continuously monitors the oil’s temperature and relative moisture
saturation at the sensor location. A filtering is applied to remove the effect of cyclic heating
created by the sensor to ensure oil circulation. This filtered value is used to calculate the
absolute value of the water content in the oil, the temperature of water condensation, and
the relative saturation at the reference temperature.
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Since the oil and winding temperature varies continuously, this moving target is used with
an integrating algorithm taking into account the diffusion time constant and the temper-
ature.

The calculated value of the water content in the winding insulation allows prediction of the
bubbling temperature. It is also used in the Insulation Aging model (Chapter 8).

The sensors, rules and outputs of the Moisture and Bubbling model are illustrated in
Figure 9-1 on page 9-2.

9.1 MODEL INPUTS

• Top oil temperature
• Winding current

9.2 PARAMETERS TO CONFIGURE

Height of Oil Above the Hot Spot Area: This value is used in the calculation of the bubbling
threshold temperature. The oil column above the winding creates a pressure that prevents
the release of free gas bubbles. This value is configurable from 0 to 5 meters and the default
value is 2 meters.

Figure 9-1 - Summary of the Moisture and Bubbling Model
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Model Outputs
Type of Oil: In order to convert the relative oil saturation (RH%) into the absolute water
content in oil (ppm), it is necessary to know the water saturation curve of the oil. This curve
varies with the type of oil (naphtaneic, aromatic, vegetable or silicon) that has been selected
in the general transformer configuration page.

If the user wishes to define his water solubility curve, it can be done by providing specific
values for the factors A, B and C in the water solubility function:

ppm = RH% * EXP(B-A/(273.16 + hot-spot temperature)) + C

These parameters can be configured using the limits shown in Table 9-1 on page 9-3. The
default values correspond to naphtaneic oil.

Table 9-1 - Factors in the Water Solubility Function

Standard Temperature for RH: This value is used to convert the measured relative
saturation (RH%) to a relative saturation at a reference temperature. This reference
temperature can be configured from 0 to 40 °C with a default value of 20 °C.

Altitude of the Transformer 

Type of Oil Preservation System 

9.3 MODEL OUTPUTS

Absolute Water Content in Oil in ppm

Water-Oil Condensation Temperature: This is the critical temperature (in °C) for the
formation of free water in the insulating oil when a wet transformer is allowed to cool down
rapidly. If the water dissolved in the oil does not have sufficient time to migrate back to the
cellulose insulation, droplets of free water may precipitate in the oil. This would create a
hazard for dielectric failure should the transformer be reenergized in this condition.

Minimum Value Maximum Value Default Value

A 1,000 10,000 4,107.18

B 10 25 17.749

C 0 10 2.41
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Moisture Content in Winding Paper: This value is expressed in percentage weight by
weight.

Moisture Content in Winding Paper Validation Delay: The migration of moisture between
the oil and the paper is a slow process governed by the moisture content and the diffusion
time constant. At system commissioning, it is not possible to provide and immediate value
of moisture content in the paper. Data may need to be integrated over several days or weeks
before a reliable value can be displayed. This delay is calculated considering the current
temperature conditions and the time elapsed since the system was commissioned.

Winding Bubbling Temperature: Residual moisture in the winding insulation can release
free gas bubbles if the hot-spot temperature is too high or increasing rapidly. The bubble
inception temperature is function of the moisture content in the paper and also the oil
pressure and partial vapor pressure in the area of the winding hot-spot.

Winding Bubbling Temperature Margin: This is the difference between the bubbling
inception temperature and the actual winding hot-spot temperature.

9.4 ASSOCIATED ALARMS

Water-in-Oil Condensation Temperature Alarm: This alarm is normally set to alert the
operator when the condensation temperature exceeds the minimum temperature that can be
observed on the transformer, should it be suddenly removed from service. This value can
be configured from -40 to +20 °C with a default value of -20 °C.

Bubbling Temperature Margin Alarm: A significant margin should be maintained at all
time to avoid the occurrence of free bubbles circulation in the cooling oil. This margin can
be configured from 0 to 50 °C with a default value of 20 °C.

Note: Appendix B presents the list of all alarm messages that can appear on the Hydran M2
Host (DNP) software.

9.5 MAIN WINDOW

The main window for the Moisture and Bubbling model is shown in Figure 9-2 on page 9-5.
The commands applying to all monitoring models are explained in Chapter 5.
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Main Window
By default, the following five outputs are displayed:

• Moisture Content in Winding Paper
• Winding Bubbling Temperature
• Winding Bubbling Temperature Margin
• Water-Oil Condensation Temperature
• H2O PPM Level

Figure 9-2 - Main Window for the Moisture and Bubbling Model
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PAGE LEFT INTENTIONALLY BLANK
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Chapter 10

Moisture Content in Insulating Barrier Model

The moisture content in the solid insulation can significantly reduce the dielectric strength
of the components submitted to high electric fields. This effect is especially critical for
partial discharges inception on barriers that provide insulation between the windings and
that can be submitted to tangential electric fields.

The most critical pressboard barriers are at the bottom oil temperature because this is the
coolest area and this is where the moisture content in solid insulation will be the highest.
Ideally, a sensor providing a measured value of the bottom oil temperature should be
connected as an input. If this is not available, the Hydran M2 will use a calculated value
that takes into account the load, the cooling stage, the rated top oil rise and the rated bottom
oil rise under each cooling mode, as well as the effect of the altitude on the cooling charac-
teristics.

Knowing the bottom oil temperature, the relative oil saturation in this area can be
calculated. The oil-to-paper equilibrium curves providing an ultimate value of the moisture
in the paper at those conditions would be maintained continuously.

The value of the water content in pressboard barriers can be used to evaluate the reduction
of dielectric strength of this component.

The sensors, rules and outputs of the Moisture Content in Insulating Barrier model are
illustrated in Figure 10-1 on page 10-2.

10.1 MODEL INPUTS

• Top oil temperature
• Load current on Winding H
• Bottom Oil Temperature
• Fan feedback status of cooling bank #1 (optional)
• Fan feedback status of cooling bank #2 (optional)
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10.2 PARAMETERS TO CONFIGURE IF NO BOTTOM OIL MEASUREMENT 
IS AVAILABLE

Load Losses on Top Cooling Stage: This value is needed to calculate the temperature drop
between the measured top oil temperature and the calculated bottom oil temperature. It can
be configured from 10 to 10,000 kW with a default value of 500 kW.

No Load Losses at Rated Voltage: This value is needed to calculate the temperature drop
between the measured top oil temperature and the calculated bottom oil temperature. It can
be configured from 2 to 2,000 kW with a default value of 100 kW.

Rated Power at Cooling Stage 0: The cooling stage 0 is defined as the lowest cooling stage
that can be used on a transformer. It can be the ONAN mode, or OFAN if there are some
oil pumps. Stages 1 and 2 are under the control of the cooling system control but stage 0 is
not under this control. Some transformers have only one cooling stage (typically GSU with
OFWF cooling mode); in this case the rated power is to be configured as cooling stage 0.
The rated power under cooling stage 0 can be found on the transformer’s nameplate. It can
be configured from 1 to 600 MVA with a default value of 100 MVA.

Rated Power at Cooling Stage 1: In general, cooling stage 1 can be initiated by activating
either cooling bank 1 or 2. It is therefore necessary to distinguish between cooling bank and
cooling stage. The rated power under cooling stage 1 is to be found on the transformer’s
nameplate. It can be configured from 1 to 800 MVA with a default value of 150 MVA.

Figure 10-1 - Summary of the Moisture Content in Insulating Barrier Model
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Parameters to Configure IF NO Bottom Oil Measurement Is Available
Some transformers have only one cooling bank that can be controlled; in this case, the two
rated values indicated on the nameplate are to be configured as cooling stages 0 and 1.

Rated Power at Cooling Stage 2: The cooling stage 2 is available when both cooling banks
are in service. The rated power at cooling stage 2 can be found on the transformer’s
nameplate. It can be configured from 1 to 1,000 MVA with a default value of 200 MVA.

Oil Exponent at Cooling Stage 0, Oil Exponent at Cooling Stage 1 and Oil Exponent at
Cooling Stage 2: The oil exponent is a parameter defining the relation between the load and
the top oil temperature rise. This value is configurable from 0.5 to 1.0 with a default value
of 0.8. The best method to establish this value is to run several temperature rise tests as
described in IEEE C57.119 - Recommended Practices for Performing Temperature Rise
Tests on Oil-Immersed Power Transformers at Loads Beyond Nameplate Rating.
Otherwise, the following approximate oil exponent values related to the cooling mode of
each cooling stage can be used:

• 0.8 for the ONAN cooling mode
• 0.9 for the ONAF, OFAN, OFAF and OFWF cooling modes
• 1.0 for the ODAN, ODAF and ODWF cooling modes

Rated Top Oil Rise at Cooling Stage 0, Rated Top Oil Rise at Cooling Stage 1 and Rated
Top Oil Rise at Cooling Stage 2: These are the top oil temperature rises over the ambient
temperature, when the transformer is loaded at the rated load applicable to cooling stages 0,
1 and 2. These values can be found on the transformer’s temperature rise test report if such
test has been done on cooling stages 0, 1 and 2. If not, the values can be obtained from the
manufacturer or estimated from similar transformers. These values are configurable from
20 to 80 °C with a default value of 55 °C.

Altitude of the Transformer: As the altitude increases, the air density reduces and cooling
is less efficient. The altitude value allows the Hydran M2 to calculate a reduced value of
the rated current that will produce the same top oil temperature rise. The correction factor
varies with the type of cooling, in line with IEEE C.57.91-1995. The altitude value is
configurable from 0 to 5,000 meters with a default value of 500 meters.

Rated Bottom Oil Rise at Cooling Stage 0, Rated Bottom Oil Rise at Cooling Stage 1 and
Rated Bottom Oil Rise at Cooling Stage 2: These are the differences between the oil
temperature at the bottom of the transformer and the ambient temperature, when the
transformer is loaded at the rated load, applicable to cooling stages 0, 1 and 2. These values
can be found on the transformer’s temperature rise test report if such test has been done on
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cooling stages 0, 1 and 2. If not, the values can be obtained from the manufacturer or
estimated from similar transformers. These values are configurable from 10 to 60 °C with
a default value of 25 °C.

10.3 MODEL OUTPUTS

• Calculated Bottom Oil Temperature (if the bottom oil temperature is not available as an
input)

• Moisture Content in Insulating Barrier
• Moisture Content in Insulating Barrier Valid Delay

10.4 MAIN WINDOW

The Moisture Content in Insulating Barrier model is displayed in the main window for the
Moisture and Bubbling model, shown in Figure 9-2 on page 9-5. The commands applying
to all monitoring models are explained in Chapter 5.

By default, the following two outputs are displayed:

• Moisture Content in Insulating Barrier
• Calculated Bottom Oil Temperature
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Chapter 11

Cooling Efficiency Model

This model computes the top oil temperature that should be expected considering the load
current, the ambient temperature, the cooling mode, the oil time constant and the altitude.
The calculated value is then compared with the measured value and an alarm is raised if the
transformer is found to be overheating. This calculation allows for the detection of obstruc-
tions, such as dirt on the coolers, which could be a limiting factor when the transformer is
required to operate at full load or under overload conditions.

During the initial model computation, the measured values of top oil temperature and
ambient temperature are used to provide a starting point for the calculated value of top oil
temperature rise. From then on, the calculated temperature at the end of the time interval is
used as the initial temperature for the next time interval. This calculation is run with load
current in the H winding only. The rated current for each cooling stage is calculated from
the rated power on each stage and the rated current on the top cooling stage.

The ultimate temperature rise and the current temperature rise are calculated considering
the actual cooling stage and the actual oil time constant. This value is added to the ambient
temperature to provide a calculated top oil temperature. This value is subtracted from the
measured top oil temperature and the difference is averaged over a configurable period. An
alarm is raised when the difference exceeds a configured value for a period of time that is
also configurable.

The model can accommodate a transformer with one, two or three cooling stages.

Note: If the transformer is not energized, it is important to remove the core losses when
calculating the top oil temperature. Otherwise a false alarm could be generated.

The sensors, rules and outputs of the Cooling Efficiency model are illustrated in
Figure 11-1 on page 11-2.
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11.1 MODEL INPUTS

• Top oil temperature
• Load current on Winding H
• Ambient Temperature
• Fan feedback status of cooling bank #1
• Fan feedback status of cooling bank #2
• Transformer Energized status (optional)

11.2 PARAMETERS TO CONFIGURE

Rated Current in Winding H on Top Cooling Stage: This model considers only the current
in the H winding to calculate the actual loading. The rated value of this current is compared
to the measured value to derive a Per Unit (p.u.) value. The rated current on the top cooling
mode can be found on the transformer’s nameplate. This value is configurable from 1 to
5,000 A. Before configuration, a default value of 250 A is shown.

Load Losses on Top Cooling Stage: This value is needed to calculate the temperature drop
between the measured top oil temperature and the calculated bottom oil temperature. It can
be configured from 10 to 10,000 kW with a default value of 500 kW.

No Load Losses at Rated Voltage: This value is needed to calculate the temperature drop
between the measured top oil temperature and the calculated bottom oil temperature. It can
be configured from 2 to 2,000 kW with a default value of 100 kW.

Figure 11-1 - Summary of the Cooling Efficiency Model
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Parameters to Configure
Rated Power at Cooling Stage 0: The cooling stage 0 is defined as the lowest cooling stage
that can be used on a transformer. It can be the ONAN mode, or OFAN if there are some
oil pumps. Stages 1 and 2 are under the control of the cooling system control but stage 0 is
not under this control. Some transformers have only one cooling stage (typically GSU with
OFWF cooling mode); in this case the rated power is to be configured as cooling stage 0.
The rated power under cooling stage 0 can be found on the transformer’s nameplate. It can
be configured from 1 to 600 MVA with a default value of 100 MVA.

Rated Power at Cooling Stage 1: In general, cooling stage 1 can be initiated by activating
either cooling bank 1 or 2. It is therefore necessary to distinguish between cooling bank and
cooling stage. The rated power under cooling stage 1 is to be found on the transformer’s
nameplate. It can be configured from 1 to 800 MVA with a default value of 150 MVA.
Some transformers have only one cooling bank that can be controlled; in this case, the two
rated values indicated on the nameplate are to be configured as cooling stages 0 and 1.

Rated Power at Cooling Stage 2: The cooling stage 2 is available when both cooling banks
are in service. The rated power at cooling stage 2 can be found on the transformer’s
nameplate. It can be configured from 1 to 1,000 MVA with a default value of 200 MVA.

Type of Cooling for Stage 0, Type of Cooling for Stage 1 and Type of Cooling for Stage 2:
Select in the menu the standard type of cooling that is applicable for cooling stages 0, 1 and
2.

Oil Exponent at Cooling Stage 0, Oil Exponent at Cooling Stage 1 and Oil Exponent at
Cooling Stage 2: The oil exponent is a parameter defining the relation between the load and
the top oil temperature rise. This value is configurable from 0.5 to 1.0 with a default value
of 0.8. The best method to establish this value is to run several temperature rise tests as
described in IEEE C57.119 - Recommended Practices for Performing Temperature Rise
Tests on Oil-Immersed Power Transformers at Loads Beyond Nameplate Rating.
Otherwise, the following approximate oil exponent values related to the cooling mode of
each cooling stage can be used:

• 0.8 for the ONAN cooling mode
• 0.9 for the ONAF, OFAN, OFAF and OFWF cooling modes
• 1.0 for the ODAN, ODAF and ODWF cooling modes

Rated Top Oil Rise at Cooling Stage 0, Rated Top Oil Rise at Cooling Stage 1 and Rated
Top Oil Rise at Cooling Stage 2: These are the top oil temperature rises over the ambient
temperature, when the transformer is loaded at the rated load applicable to cooling stages 0,
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1 and 2. These values can be found on the transformer’s temperature rise test report if such
test has been done on cooling stages 0, 1 and 2. If not, the values can be obtained from the
manufacturer or estimated from similar transformers. These values are configurable from
20 to 80 °C with a default value of 55 °C.

Rated Top Oil Time Constant: The thermal time constant of the top oil is needed to calculate
the effect of a load change on the oil temperature change. This time constant can be derived
from the temperature rise test report or it can be calculated from the weight of the core,
windings and oil as recommended in IEEE C.57.91-1995. This value is configurable from
0.5 to 8 hours with a default value of 3 hours.

Cooling Efficiency Averaging Period: The cooling efficiency is computed from the
difference between the calculated and measured top oil temperature values. To avoid false
alarms due to sudden variations of ambient or load conditions, the difference is averaged
over a period of time. This averaging period can be configured from 60 to 2,880 minutes
with a default value of 1,440 minutes.

Altitude of the Transformer: As the altitude increases, the air density reduces and cooling
is less efficient. The altitude value allows the Hydran M2 to calculate a reduced value of
the rated current that will produce the same top oil temperature rise. The correction factor
varies with the type of cooling, in line with IEEE C.57.91-1995. The altitude value is
configurable from 0 to 5,000 meters with a default value of 500 meters.

11.3 MODEL OUTPUTS

• Calculated Top Oil Temperature
• Calculated Top Oil Difference
• Calculated Bottom Oil Temperature (if the bottom oil temperature is not available as an

input)
• Cooling Efficiency Index

11.4 ASSOCIATED ALARMS

Cooling Efficiency Index Hi Alarm: This alarm indicates that the transformer is operating
at a higher temperature than it should, considering the recent load and recent ambient
conditions. Although it does not present an immediate threat for transformer life duration,
it indicates that the cooling system is not performing as it should and could mean excessive
temperature if the transformer is requested to operate at full load or under overload
11-4 Rev. 6, December 2010 Part 17659



Main Window
conditions. The set point for this alarm is configurable from 0 to 50 °C with a default value
of 10 °C.

Note: Appendix B presents the list of all alarm messages that can appear on the Hydran M2
Host (DNP) software.

11.5 MAIN WINDOW

The main window for the Cooling Efficiency model is shown in Figure 11-2 on page 11-5.
The commands applying to all monitoring models are explained in Chapter 5.

By default, the following four analog and two digital signals are displayed:

• Top Oil Temperature

Figure 11-2 - Main Window for the Cooling Efficiency Model
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• Ambient Temperature
• Calculated Top Oil Temperature
• Cooling Efficiency Index
• Cooling Bank 1 Status
• Cooling Bank 2 Status
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Chapter 12

Cooling Banks Status Model

The digital indication of cooling bank status can be used as a prime source of information.
Transformers usually have two or three ratings related to the three different cooling stages.
The lowest rating is defined as “cooling stage 0” and usually applies to the natural cooling
of the transformer tank without any fan or pump. Similarly, cooling stages 1 and 2 imply
the starting of fans or pumps that increase the cooling capacity.

Since permutation of fan operation is intended, activating either bank 1 or 2 enables cooling
stage 1. The cooling stage 2 implies that both bank 1 and bank 2 fans are activated.

Some transformers (such as GSU indoor) have only one cooling stage; thus whenever the
transformer is energized, the full cooling is automatically initiated. These units are treated
as having only cooling stage 0.

The sensors, rules and outputs of the Cooling Banks Status model are illustrated in
Figure 12-1 on page 12-1.

Figure 12-1 - Summary of the Cooling Banks Status Model
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12.1 MODEL INPUTS

• Fan feedback status of cooling bank #1
• Fan feedback status of cooling bank #2

12.2 PARAMETERS TO CONFIGURE

Number of Cooling Banks: The number of cooling banks that can be activated from the
cooling control unit. This number can be 0 (if the transformer has only one cooling stage),
1 or 2. Default value is 2.

Type of Cooling for Stage 0, Type of Cooling for Stage 1 and Type of Cooling for Stage 2:
Select in the menu the cooling modes that are applicable for cooling stages 0, 1 and 2.

12.3 MODEL OUTPUTS

Cooling Status on (Present Cooling Stage): Displays the cooling stage presently in service.

Cooling Bank 1 Feedback Status and Cooling Bank 2 Feedback Status: Current status of
cooling banks 1 and 2.

Cooling Bank 1 Total Activity Time and Cooling Bank 2 Total Activity Time: The total
cumulative time (since system commissioning) that the transformer has been operated
without any cooling bank.

12.4 MAIN WINDOW

The main window for the Cooling Banks Status model is shown in Figure 12-2 on
page 12-3. The commands applying to all monitoring models are explained in Chapter 5.

By default, the following three analog and two digital signals are displayed:

• Top Oil Temperature
• Current Winding H
• Current Winding X
• Cooling Bank 1 Status
• Cooling Bank 2 Status
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Figure 12-2 - Main Window for the Cooling Banks Status Model
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PAGE LEFT INTENTIONALLY BLANK
12-4 Rev. 6, December 2010 Part 17659



Chapter 13

OLTC Position Tracking Model

Tap changer driving mechanisms are always provided with a visual tap position indicator
and a counter indicating the total number of operations. This model provides additional
information that is useful to monitor the proper operation of this critical device, such as:

• The cumulative number of operations at each tap since commissioning
• Resettable variables for operation and maintenance counts
• Warnings for excessive number of operations over a certain period
• The time spent since the last operation of the reversing switch and a warning to avoid

contact cooking because of insufficient operation

A position transducer, driven by the visual indicator shaft (also called Geneva shaft),
provides a 4–20 mA signal that is proportional to the tap changer mechanical position. The
multi-position switch can be equipped with jumpers (instead of resistors) in the “through
positions” where the tap position indicator will stay only momentarily during operation of
the reversing switch. In this case, the potentiometer provides an indication of the electric
position of the tap changer. When the tap changer operates, the signal should remain steady,
until it changes to a new value without falling to zero.

It is assumed that the Geneva shaft rotates by a fixed value for each step on the transducer.
The signal from the Geneva shaft position transducer is read at regular intervals and is
analyzed to determine the actual position of the visual position indicator.

The position generated may refer to the mechanical position of the Geneva gear or the
electrical position. In the first case, the mechanical position is converted into the electrical
position considering the number of through positions specific to this tap changer when it
moves to the neutral position.

The number of operations on each tap position is presented by histograms using the tap
position denomination configured by the user. The system provides three separate registers
to record the number of operations carried out by the tap changer:

• The Permanent Tap Position Transition Count is intended to be the summation of all
operations since the commissioning of the system. However, if the monitoring system is
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moved to a different transformer, the System Administrator can reset this value to zero.
This counter provides the number of operations on each tap position, the total number of
operations, and the date when the system was put is service. The total number of
operations performed prior to the commissioning of the system can also be taken into
account.

• The Operator Tap Position Transition Count can be reset by the Operator when there is
need to check the number of operations in one or several days to demonstrate that the tap
changer control unit is operating properly. This counter provides the number of
operations on each tap position, the maximum and minimum position visited by the tap
changer since the last reset, and the date of the last reset.

• The Maintenance Tap Position Transition Count is used by maintenance personnel to
assess the need for maintenance and to plan maintenance schedules. It will be typically
reset every three or four years when an inspection activity is preformed on the unit. This
counter provides the number of operations on each tap position, the maximum and
minimum position visited by the tap changer since the last reset, and the date of the last
reset.

The sensors, rules and outputs of the OLTC Position Tracking model are illustrated in
Figure 13-1 on page 13-2.

13.1 MODEL INPUTS

• Tap Position

Figure 13-1 - Summary of the OLTC Position Tracking Model
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13.2 PARAMETERS TO CONFIGURE

Total Number of Positions on the Tap Changer: The total number of mechanical positions
that are used by the tap changer. This value comprises the total number of electrical tap
positions plus the through positions. This value is configurable from 1 to 35 with a default
value of 19.

Middle Position: Indicates the tap position that provides the rated voltage at mid tap.

Through Positions: In order to convert the mechanical position of the driving mechanism
to the electrical position of the tap changer, the number of through positions is needed.
These are the intermediate positions that take place when the tap changer goes through the
neutral position. Information is available in the tap changer operation manual. If the
position transducer is equipped with jumpers (instead of resistors) in the through position,
enter a zero value in this field.

Tap Position Polarity: This information will define the type of display used in the OLTC
Position Tracking model window. This value is to be selected from Table 13-1 on
page 13-3 illustrating a tap changer with 17 electrical positions.

Table 13-1 - Tap Positions

Tap Position Units (-/+): This value complements the preceding one by indicating whether
the signs “-” and “+” or the symbols “L” and “R” are to be used. For “Bipolar” and “Bipolar
Reverse,” the units can be set to any character, the first character designating the left side,
and the second character the second side.

Real Tap Position Count 

Lowest Tap Middle Tap Maximum Tap

Absolute 1 9 17

Absolute Reverse 17 9 1

Bipolar L8 0 R8

Bipolar Reverse R8 0 L8
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Actual Tap Position: The number of positions that the tap changer can take. The value can
be found on the tap changer nameplate. This value can be configured from 3 to 35 with a
default value of 17.

Number of Operations Since Last Maintenance Setpoint: The number of operations that is
deemed acceptable between two successive maintenance operations. This value can be
configured from 10,000 to 200,000 operations with a default value of 30,000 operations.

Elapsed Time Since Last Maintenance Setpoint: The maximum time duration that is
allowed between successive maintenance operations. This value can be configured from 1
to 10 years with a default value of 5 years.

Days Elapsed Since Last Reversing Switch Operation Setpoint: Tap changers should not be
left on the same position of the reversing switch for an excessive length of time. Contacts
that are not being operated tend to overheat and develop carbon that will collect around the
contact. Manufacturers normally recommend that this contact be operated at least once a
year. This value is configurable from 100 to 1,000 days with a default value of 365 days.

Maximum Number of Tap Operations per Hour Setpoint: An abnormal network condition
or an unsuitable setting of the tap changer control system can lead to an excessive number
of operations that will wear unduly the tap changer. The value for the maximum number of
operations per hour can be configured from 5 to 100 operations with a default value of 10.

Maximum Number of Tap Operations per Day Setpoint: An abnormal network condition or
an unsuitable setting of the tap changer control system can lead to an excessive number of
operations that will wear unduly the tap changer. The value for the maximum number of
operation per day can be configured from 20 to 1,000 operations with a default value of
100.

13.3 MODEL OUTPUTS

• Actual Tap Position
• Elapsed Time Since Last Maintenance Reset
• Elapsed Days Since Last Reversing Switch Operation
• Last Hour Operation Count
• Last Day Operation Count
• Last Permanent Tap Position Reset Time Stamp
• Permanent Tap Position Transition Count
• Permanent Count for Positions 1-35
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Associated Alarms
• Last Operator Tap Position Reset Time Stamp
• Operator Tap Position Transition Count

– Historic Min for Tap Position
– Historic Min Timestamp for Tap Position
– Historic Max for Tap Position
– Historic Max Timestamp for Tap Position

• Resettable Count for Positions 1-35
• Last Maintenance Tap Position Reset Time Stamp
• Maintenance Tap Position Transition Count

– Historic Min for Maintenance Tap Position
– Historic Min Timestamp for Maintenance Tap Position
– Historic Max for Maintenance Tap Position
– Historic Max Timestamp for Maintenance Tap Position

• Maintenance Count for Positions 1-35

Note: When viewed in historic mode, the OLTC Position Tracking model only displays the
tap positions that had been viewed the last time in real time.

13.4 ASSOCIATED ALARMS

Number of Operations Since Last Maintenance: This alarm indicates that the number of
operations since the last maintenance has exceeded the setpoint.

Elapsed Time Since Last Maintenance: This alarm indicates that the time elapsed since the
last maintenance has exceeded the setpoint.

Days Elapsed Since Last Reversing Switch Operation: This alarm indicates that the time
elapsed since the last operation of the reversing switch has exceeded the setpoint.

Maximum Number of Tap Operations per Hour and Maximum Number of Tap Operations
per Day: These alarms indicate that the numbers of operations per hour or per day have
exceeded the setpoints.

Note: Appendix B presents the list of all alarm messages that can appear on the Hydran M2
Host (DNP) software.
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13.5 MAIN WINDOW

The main window for the OLTC Position Tracking model is shown in Figure 13-2 on
page 13-6.

• On the left side, a table shows the count of permanent positions, resettable positions and
maintenance positions.

• On the right side, the same data is displayed graphically.
• Each graph has a Reset button associated to it. However, the permanent position’s Reset

button, used to reset all the fields, is protected by the level-3 password (refer to
Section 2.2 on page 2-3).

• On the top, other information relative to the OLTC tap position is displayed.

Figure 13-2 - Main Window for the OLTC Position Tracking Model
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Chapter 14

OLTC Temperature Differential Model

The On-Load Tap Changer (OLTC) Temperature Differential model continuously
compares the top oil temperature in the main tank with the tap changer compartment
temperature. Monitoring of the tap changer temperature is a recognized method of
detecting abnormal operating conditions in the tap changer. This monitoring method is
intended for tap changers mounted on a separate compartment on the transformer tank. The
tap changer temperature is normally lower than the main tank temperature because no heat
source is expected in the tap changer. If the tap changer temperature rises above the main
tank temperature, it is indicative of an overheating contact.

The temperature difference is calculated by subtracting the tap changer temperature minus
the main tank temperature, thus yielding a negative value. This method allows to set the
alarm on a positive threshold value rather than a negative value. This temperature
difference is averaged with a low-pass filter to eliminate normal variations arising from
sunshine and wind.

A short-term averaged value is generated with a configurable filtering factor typically set
at 60 minutes. This short-term average is intended to detect severe heat sources such as
resistor overheating when the mechanical links break while the switches are between two
contacts.

A long-term averaged value is generated with a configurable filtering factor typically set at
seven days. This long-term average is intended to detect slow-evolving thermal problems
such as contact overheating. The measured temperature difference is averaged over a round
number of days to filter out the daily temperature variations.

The sensors, rules and outputs of the OLTC Temperature Differential model are illustrated
in Figure 14-1 on page 14-2.

14.1 MODEL INPUTS

• Top Oil Temperature
• OLTC Main Tank Temperature
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14.2 PARAMETERS TO CONFIGURE

Short-Term Filtering Value: The major problems in the tap changer, such as an incomplete
operation of the selector switch, are better detected with a short-term filtering. The short-
term filtering value can be configured from 5 to 1,380 minutes with a default value of
60 minutes.

Long-Term Filtering Value: The slow-evolving thermal problems such as contact
overheating are better detected with a long-term filtering. The long-term filtering value can
be configured from 12 to 168 hours with a default value of 24 hours.

14.3 MODEL OUTPUTS

• OLTC Differential Temperature
• Short-Term Average of Tap Changer Temperature Differential
• Long-Term Average of Tap Changer Temperature Differential

14.4 ASSOCIATED ALARMS

OLTC Short-Term Temperature Differential Hi Alarm: A tap changer running 5 °C above
the main tank temperature should be closely monitored. This value is configurable from 0
to 30 °C.

Figure 14-1 - Summary of the OLTC Temperature Differential Model
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OLTC Short-Term Temperature Differential Hi-Hi Alarm: A tap changer running 15 °C
above the main tank temperature is a serious concern. This value is configurable from 0 to
40 °C.

OLTC Long-Term Temperature Differential Hi Alarm: A tap changer running continuously
3 °C above the main tank temperature should be closely monitored. This value is configu-
rable from 0 to 20 °C.

OLTC Long-Term Temperature Differential Hi-Hi Alarm: A tap changer running continu-
ously at 10 °C above the main tank temperature is a serious concern. This value is config-
urable from 0 to 30 °C.

Note: Appendix B presents the list of all alarm messages that can appear on the Hydran M2
Host (DNP) software.

14.5 MAIN WINDOW

The main window for the OLTC Temperature Differential model is shown in Figure 14-2
on page 14-4. The commands applying to all monitoring models are explained in Chapter 5.

By default, the following five analog signals are displayed:

• Top Oil Temperature
• OLTC Tank Temperature
• OLTC Temperature Differential
• Long-Term Average of Tap Changer Temperature
• Short-Term Average of Tap Changer Temperature
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Chapter 14 • OLTC Temperature Differential Model
Figure 14-2 - Main Window for the OLTC Temperature Differential Model
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Appendix A

Software License for the Hydran M2 Host (DNP) Software

In order to access the Hydran M2 Host (DNP) software, you must agree to be bound
by the terms of this Software End User License Agreement:

The Hydran M2 Host (DNP) software is subject to the General Electric Canada Software
End User License Agreement and is otherwise protected by copyright law and international
treaties. Any unauthorized use, reproduction or distribution of this computer program, or
any portion of it, is not permitted and may result in civil and criminal penalties. This
program is proprietary to General Electric Canada and its copyright rights in this program
shall be enforced.

You may not reverse engineer, decompile, sell, distribute, or commercially exploit this
software. You should treat this software just like any other copyrighted material. General
Electric Canada authorizes you to make archive copies of this software for the purposes of
backing up your software and protecting your investment from loss, and to make additional
copies for use within your company or facilities.

This software is licensed for use only with the Hydran M2.

The information contained in the program documentation is the sole property of General
Electric Canada. This program documentation cannot, in whole or in part, be copied, photo-
copied, reproduced, altered, translated or reduced to any electronic medium or machine-
readable form by any means without the prior written consent of General Electric Canada.

This software and its accompanying materials in printed and/or electronic form may
contain reference to, or information about, General Electric Canada products (equipment or
programs), that are not now available. Such references or information must not be
construed to mean that General Electric Canada intends to provide such products,
programming, or services.

For more information, please write to transformermonitoring@ge.com or visit
www.ge.com/energy.
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* Trademarks or registered trademarks of General Electric Company and/or General
Electric Canada.
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Appendix B

Alarm Messages

Table B-1 on page B-1 presents the list of all alarm messages that can be displayed by the
Hydran M2 and that can appear on the Hydran M2 Host (DNP) software.

Note: Some model-related alarms can only be generated if two specific models are enabled.

Table B-1 - Alarm Messages on the Hydran M2 Display and on the Hydran M2 Host (DNP) Software

Alarm Name
Alarm Message on 

the Hydran M2 
Display

Alarm Message on the 
Hydran M2 Host (DNP) 

Software

Hydran Level Hi Alarm Hydran Level Hi Alarm Hydran Level High Alarm

Hydran Level Hi-Hi Alarm Hydran Level Hi-Hi Alr Hydran Level High-High Alarm

Hydran Hourly Trend Hi Alarm Hydran Hr.Tr. Hi Alarm Hydran Hourly Trend High Alarm

Hydran Hourly Trend Hi-Hi 
Alarm

Hydran Hr.Tr. H-H Alr
Hydran Hourly Trend High-High 
Alarm

Hydran Daily Trend Hi Alarm Hydran Dy.Tr. Hi Alr Hydran Daily Trend High Alarm

Hydran Daily Trend Hi-Hi Alarm Hydran Dy.Tr. H-H Alr
Hydran Daily Trend High-High 
Alarm

%RH Level Hi Alarm %RH Hi Alarm %RH Level High Alarm

%RH Level Hi-Hi Alarm %RH Hi-Hi Alarm %RH Level High-High Alarm

H2O PPM Level Hi Alarm H2O PPM Hi Alarm H2O PPM Level High Alarm

H2O PPM Level Hi-Hi Alarm H2O PPM Hi-Hi Alarm H2O PPM Level High-High Alarm

%RH Hourly Average Hi Alarm %RH Avg.Hi Alarm %RH Hourly Average High Alarm

%RH Hourly Average Hi-Hi 
Alarm

%RH Avg. Hi-Hi Alr
%RH Hourly Average High-High 
Alarm

H2O PPM Hourly Average Hi 
Alarm

H2O PPM Avg. Hi Alr
H2O PPM Hourly Average High 
Alarm

H2O PPM Hourly Average Hi-Hi 
Alarm

H2O PPM Av. H-H Alr
H2O PPM Hourly Average High-
High Alarm
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Hydran Sensor Temp Low-Low 
Alarm

S. Temp L-Low Alr
Hydran Sensor Temp Low-Low 
Alarm

Hydran Sensor Temp Low Alarm S. Temp Low Alarm Hydran Sensor Temp Low Alarm

Hydran Sensor Temp Hi Alarm S. Temp Hi Alarm Hydran Sensor Temp High Alarm

Hydran Sensor Temp Hi-Hi 
Alarm

S. Temp Hi-Hi Alarm
Hydran Sensor Temp High-High 
Alarm

Hydran Sensor Temp Input Fault S. Temp Input Fault Hydran Sensor Temp Input Fault

Base Plate Temperature Low-Low 
Alarm

B.P. Temp L-L Alr
Base Plate Temperature Low-Low 
Alarm

Base Plate Temperature Low 
Alarm

B.P.Temp Low Alarm
Base Plate Temperature Low 
Alarm

Base Plate Temperature Hi Alarm B.P. Temp Hi Alarm
Base Plate Temperature High 
Alarm

Base Plate Temperature Hi-Hi 
Alarm

B.P. Temp Hi-Hi Alr
Base Plate Temperature High-High 
Alarm

Base Plate Temperature Input 
Fault

B.P. Temp Input Fault Base Plate Temperature Input Fault

Battery Low-Low Alarm Battery L-Low Alrm Battery Low-Low Alarm

Battery Low Alarm Battery Low Alarm Battery Low Alarm

(An. User Defined #1) Low-Low 
Alarm

AnUsrDf#1 LL Alr
An. User Defined #1 Low-Low 
Alarm

(An. User Defined #1) Low Alarm AnUsrDf#1 Low Alr An. User Defined #1 Low Alarm

(An. User Defined #1) Hi Alarm AnUsrDf#1 Hi Alr An. User Defined #1 High Alarm

(An. User Defined #1) Hi-Hi 
Alarm

AnUsrDf#1 HH Alr
An. User Defined #1 High-High 
Alarm

(An. User Defined #1) Input Fault 
Alarm

AnUsrDf#1 Inp. Fault
Analog User Def #1 Input Fault 
Alarm

(An. User Defined #2) Low-Low 
Alarm

AnUsrDf#2 LL Alr
An. User Defined #2 Low-Low 
Alarm

(An. User Defined #2) Low Alarm AnUsrDf#2 Low Alr An. User Defined #2 Low Alarm

(An. User Defined #2) Hi Alarm AnUsrDf#2 Hi Alr An. User Defined #2 High Alarm

Alarm Name
Alarm Message on 

the Hydran M2 
Display

Alarm Message on the 
Hydran M2 Host (DNP) 

Software
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(An. User Defined #2) Hi-Hi 
Alarm

AnUsrDf#2 HH Alr
An. User Defined #2 High-High 
Alarm

(An. User Defined #2) Input Fault 
Alarm

AnUsrDf#2 Inp. Fault
Analog User Defined #2 Input 
Fault Alarm

(An. User Defined #3) Low-Low 
Alarm

AnUsrDf#3 LL Alr
An. User Defined #3 Low-Low 
Alarm

(An. User Defined #3) Low Alarm AnUsrDf#3 Low Alr An. User Defined #3 Low Alarm

(An. User Defined #3) Hi Alarm AnUsrDf#3 Hi Alr An. User Defined #3 High Alarm

(An. User Defined #3) Hi-Hi 
Alarm

AnUsrDf#3 HH Alr
An. User Defined #3 High-High 
Alarm

(An. User Defined #3) Input Fault 
Alarm

AnUsrDf#3 Inp. Fault
Analog User Defined #3 Input 
Fault Alarm

(An. User Defined #4) Low-Low 
Alarm

AnUsrDf#4 LL Alr
An. User Defined #4 Low-Low 
Alarm

(An. User Defined #4) Low Alarm AnUsrDf#4 Low Alr An. User Defined #4 Low Alarm

(An. User Defined #4) Hi Alarm AnUsrDf#4 Hi Alr An. User Defined #4 High Alarm

(An. User Defined #4) Hi-Hi 
Alarm

AnUsrDf#4 HH Alr
An. User Defined #4 High-High 
Alarm

(An. User Defined #4) Input Fault 
Alarm

AnUsrDf#4 Inp. Fault
Analog User Defined #4 Input 
Fault Alarm

Top Oil Temperature Input Fault 
Alarm

Top Oil Input Fault
Top Oil Temperature Input Fault 
Alarm

Top Oil Temperature Hi-Hi Alarm Top Oil Hi-Hi Alarm
Top Oil Temperature High-High 
Alarm

Top Oil Temperature Hi Alarm Top Oil Hi Alarm Top Oil Temperature High Alarm

Winding Hot-Spot Temperature 
Hi-Hi Alarm

WHST Hi-Hi Alarm
Winding Hot-Spot Temperature 
High-High Alarm

Winding Hot-Spot Temperature 
Hi Alarm

WHST Hi Alarm
Winding Hot-Spot Temperature 
High Alarm

Hydran Sensor Cable Open Alarm Hyd. C.Open Alarm Hydran Sensor Cable Open Alarm

Hydran Sensor Cable Short Alarm Hyd. C.Short Alarm Hydran Sensor Cable Short Alarm

Alarm Name
Alarm Message on 

the Hydran M2 
Display

Alarm Message on the 
Hydran M2 Host (DNP) 

Software
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Hydran Replace Sensor Soon 
Alarm

Hyd. Rep.S.Soon Alr
Hydran Replace Sensor Soon 
Alarm

Hydran Replace Sensor Now 
Alarm

Hyd. Rep.S.Now Alr
Hydran Replace Sensor Now 
Alarm

Sensor Card #1 Comm. Error 
Alarm

Sens#1 Com Err.Alarm
Sensor Card #1 Comm. Error 
Alarm

OLTC Short Term Temperature 
Differential Hi-Hi Alarm

OLTC Diff. S.T. H-H Alr
OLTC Short Term Temperature 
Differential High-High Alarm

OLTC Short Term Temperature 
Differential Hi Alarm

OLTC Diff. S.T. Hi Alr
OLTC Short Term Temperature 
Differential High Alarm

OLTC Long Term Temperature 
Differential Hi-Hi Alarm

OLTC Diff. L.T. H-H Alr
OLTC Long Term Temperature 
Differential High-High Alarm

OLTC Long Term Temperature 
Differential Hi Alarm

OLTC Diff. L.T. Hi Alr
OLTC Long Term Temperature 
Differential High Alarm

Number of operations since last 
Maintenance Alarm

Op. Cnt. S. Maint. Alr
Number of operations since last 
Maintenance Alarm

Elapsed Time since last 
Maintenance Alarm

Time since Maint. Alr
Elapsed Time since last 
Maintenance Alarm

Days Elapsed since last Reversing 
Switch Operation Alarm

Day s. Rev. Sw. Op. Alr
Days Elapsed since last Reversing 
Switch Operation Alarm

Maximum Number of Tap 
Operations per Hour Alarm

Max Tap Op. per HrAlr
Maximum Number of Tap 
Operations per Hour Alarm

Maximum Number of Tap 
Operations per Day Alarm

Max Tap Op. per DyAlr
Maximum Number of Tap 
Operations per Day Alarm

Ambient Temperature Input Fault 
Alarm

Ambient Input Fault
Ambient Temperature Input Fault 
Alarm

Cooling Efficiency Index Alarm Cool. Eff. Index Alr
Cooling Efficiency Index High 
Alarm

Bottom Oil Temperature Input 
Fault Alarm

Bottom Oil Input Fault
Bottom Oil Temperature Input 
Fault Alarm

Water-Oil Condensation 
Temperature Alarm

W-Oil Cond. Temp Alr
Water-Oil Condensation 
Temperature Low Alarm

Alarm Name
Alarm Message on 

the Hydran M2 
Display

Alarm Message on the 
Hydran M2 Host (DNP) 

Software
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Bubbling Temperature Margin 
Alarm

Bubbling Temp M. Alr
Bubbling Temperature Margin 
Low Alarm

(Dg. User Defined #1) Alarm DgUsrDf#1 Alarm No alarm message!

(Dg. User Defined #2) Alarm DgUsrDf#2 Alarm No alarm message!

(Dg. User Defined #3) Alarm DgUsrDf#3 Alarm No alarm message!

(Dg. User Defined #4) Alarm DgUsrDf#4 Alarm No alarm message!

Alarm Name
Alarm Message on 

the Hydran M2 
Display

Alarm Message on the 
Hydran M2 Host (DNP) 

Software
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Appendix C

Glossary

A: Ampere

ac: Alternating Current

Adaptor (brass): Device used to mount a Hydran M2 With Models (specifically its sensor)
onto a valve of the electrical equipment to monitor (typically a transformer)

Alarm: Operating condition occurring when a data point value exceeds the parameter’s
alarm set point

Alarm Contact: Terminal used as interface between the alarm relays of the Hydran M2
With Models and any SCADA system (alarm panel, etc.)

Analog Output: Analog signal that is proportional to the gas or moisture level reading
performed by the Hydran M2 With Models

Analog Signal: Electronic signal that can represent an infinite range of numbers (as
opposed to digital signal)

Analysis: Algorithm applied to data points for the purpose of calculating features that are
then applied to rules

ANSI: American National Standards Institute, a non-governmental organization that
develops and publishes standards for voluntary use in the United States

ASTM: American Society for Testing and Materials (United States)

AWG: American Wire Gauge (United States)

bps: Bit Per Second

CD-ROM: Compact Disc - Read-Only Memory
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CE: European Conformity

CH4: Methane

C2H2: Acetylene

C2H4: Ethylene

C2H6: Ethane

Channel: Path along which data passes in the form of electrical signals

CO: Carbon monOxide

CO2: Carbon diOxide

COM: Serial COMmunication port on a PC

Combustible Gas: Fault gas in the dielectric oil of a transformer

CPU: Central Processing Unit

CSA: Canadian Standards Association

CT: Current Transmitter

Daily Trend: Variation of a gas or moisture level during an adjustable period of time
calculated in days

Daisy Chain: Parallel connection from one Hydran M2 to another using an RS-485 link
cable

dc: Direct Current

DGA: Dissolved Gas Analysis

Diagnostic: Identification of specific malfunctions of an electrical apparatus

Digital Output: Output that provides a digital signal derived from the digital information
within the instrument
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Digital Signal: Electronic signal that can only represent discrete numbers (as opposed to
analog signal)

DIN: Deutsches Institut für Normung, a german standards institute

DNP: Distributed Network Protocol

Download: Transferring data stored in the memory of the Hydran M2’s PLC to the
Hydran M2 Host’s long-term database

EC: Electronic Controller, the Intel Pentium PC responsible for data acquisition, transfer,
storage, interpretation and communications

EEC: European Economic Community

Embedded Software: Small program that runs inside the Hydran M2 With Models. It
manages the dynamic oil sampling system, monitors alarm conditions, triggers alarms,
displays the gas and moisture level readings and other values, etc. It also allows the user to
set and modify the value of every operational parameter.

EMI: ElectroMagnetic Interference

End User: Commercial client for General Electric Canada

Error: Deviation (difference or ratio) of a measurement from its true value

Esc: ESCape key on the Hydran M2’s keypad

ESD: ElectroStatic Discharge

Extended Menu: Menu of the Hydran M2’s embedded software that gives access to all
operation parameters and commands (including those of the Main Menu)

Fault: Indication (other than diagnostics) issued by the hardware or software that an
anomaly exits in the Hydran M2 With Models

FCC: Federal Communications Commission, the United States government agency
responsible for ensuring that phone lines are being used correctly and that radio interference
is at acceptable levels
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Feedback: A means of providing indication of operation either by measured values or
contact status (On/Off)

FIFO: First In, First Out. The first data into a memory buffer is the first data out of the
buffer.

Gas Level: Composite value of four dissolved gases in transformer oil, measured by the
Hydran M2 sensor

GE: General Electric

GND: GrouND (earth), a common reference point in an electric or electronic circuit

GUI: Graphical User Interface, the graphical layout designed to enable user interaction
with the Hydran M2 With Models. It enables information to be passed between a user and
hardware or software components of a computer system via graphical symbols (icons,
buttons and menus) located on a screen, accessed using a mouse, keyboard, keypad, etc.

H or Hi: High alarm

H2: Hydrogen

Hardware: The physical parts of a computer-controlled system, such as circuit boards,
chassis, peripheral devices, cables, etc.

HH, HiHi or Hi-Hi: High-High alarm

History File: Either one of four distinct groups of data (Short Term, Long Term, Events
and Service) that are recorded automatically and/or periodically and stored in the
Hydran M2’s memory

H2O: Water

Host Computer: IBM PC (or compatible) connected remotely to a Hydran M2 With
Models or a network of Hydran M2 With Models and running the Hydran M2 Host (DNP)
software

Hourly Trend: Variation of a gas or moisture level during an adjustable period of time
calculated in hours
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Hydran 201Ci: Any of the three controllers from the Hydran family of products:
Hydran 201Ci-1, Hydran 201Ci-4 or Hydran 201Ci-C. Abbreviated to H201Ci.

Hydran 201Ci-1: One-channel controller designed to supervise one Hydran 201Ti and
link it to a host computer running the Hydran Host software. This configuration is referred
to as Hydran 201R Model i. Abbreviated to H201Ci-1.

Hydran 201Ci-4: Four-channel controller designed to supervise up to four Hydran 201Ti’s
and link them to a host computer running the Hydran Host software. Abbreviated to
H201Ci-4.

Hydran 201Ci-C: Communications controller designed to supervise up to four
Hydran 201Ti’s. The Hydran 201Ci-C does not have a numerical display, analog outputs
or alarm contacts; it is meant only as an interface between the Hydran 201Ti’s and a host
computer running the Hydran Host software. Abbreviated to H201Ci-C.

Hydran 201i System: Continuous, on-line, combustible gas-in-oil monitor, taking the
form of either a Hydran 201Ti used alone or the combination of at least one Hydran 201Ti
and a Hydran 201Ci Controller

Hydran 201R Model i: Specific configuration of Hydran 201i System, which consists of
one Hydran 201Ti linked to a Hydran 201Ci-1. This combination has been designed to
replace or complete an existing installation of Hydran 201R (previous generation of
transformer incipient fault monitor).

Hydran 201 Sensor: Electrochemical gas detector used in the Hydran M2 With Models to
detect and measure a composite value of four dissolved gases in transformer oil

Hydran 201Ti: Intelligent transmitter, an IED that uses an electrochemical gas sensor to
detect and measure a composite value of four dissolved gases in transformer oil.
Abbreviated to H201Ti.

Hydran M2 Host (DNP): Microsoft Windows software that communicates, through an
RS-232 serial communication link or a modem, with one or several Hydran M2 With
Models using a host or laptop computer. It allows a user to set operational parameters,
survey alarm status, etc.
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Hydran M2 With Models: Intelligent transmitter, an IED that uses an electrochemical gas
sensor to detect and measure moisture and a composite value of four dissolved gases in
transformer oil

Hz: HertZ, a unit of frequency equal to a cycle per second

ID: IDentification

IEC: International Electrotechnical Commission

IED: Intelligent Electronic Device

IEEE: Institute of Electrical and Electronics Engineers

in: INch

I/O: Input/Output, two of the three activities (input, processing and output) characterizing
a computer. Refers to the complementary tasks of gathering data for the microprocessor to
work with and making the results available to the user through communication channels
such as the display, disk drive or printer.

Isolated Output: Output signal where a common reference is not connected to either input
terminal

L or Lo: Low alarm

Lab Data: Manually-entered gas sample data obtained from laboratory results

LAN: Local Area Network, a group of computers and other devices dispersed over a
relatively-limited area and connected by a communications link enabling any device to
interact and share with any other device or resource on the network. Usually, there is one
computer that controls all peripherals (such as printers and a hard disk drive). The other
computers are linked to the controlling computer, which lets the other computers take turns
using the peripherals.

Laptop Computer: IBM PC (or compatible) connected locally to a Hydran M2 With
Models or a network of Hydran M2 With Models and running the Hydran M2 Host (DNP)
software
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LCD: Liquid Crystal Display, a type of flat-panel display commonly used on laptops or
PC’s

LED: Light-Emitting Diode

LL, LoLo or Lo-Lo: Low-Low alarm

Local Network: Daisy chain of Hydran 201Ci Controllers connected together using an
RS-485 link in order to be monitored locally or remotely (via modem) using the Hydran M2
Host (DNP) software

Local Site: User location where the data of the remote site is being analyzed

mA: MilliAmpere

Main Menu: Menu of the Hydran M2’s embedded software that gives access to the most
frequently used operation parameters and commands

Mbps: MegaByte Per Second

Menu: Group of parameters and values accessed through a hierarchical, treelike structure

MHz: MegaHertZ, a unit of frequency equal to one million cycles per second

Modem: MOdulator/DEModulator, a communication device connecting data terminal
equipment to an analog or digital line. A modem transforms digital signals into an analog
signal suitable for transmission over telephone lines. This is the heart of computer telecom-
munications. The main factor that differentiates modems is their speed, measured in bps or
bauds.

MOV: Metal Oxide Varistor

N2: Nitrogen

NC: Normally Closed

Network: See Local Network

NO: Normally Open
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Null Modem: A special connection between two computers that makes them think they are
hooked up to a modem, so that the two computers can communicate with each other

O2: Oxygen

Oil Sample: Small quantity of oil, representative of the oil contained in the transformer

PC: Personal Computer, a computer typically based on an Intel microprocessor and capable
of receiving network cards, modems, data acquisition boards, etc.

PCB: Printed Circuit Board

PDF: Portable Document Format

PLC: Programmable Logic Controller

POT: POTentiometer

ppm: Part Per Million, representing the concentration of a gas in transformer oil

PVC: PolyVinyl Chloride, a plastic used for cable insulation

RAM: Random Access Memory, a semiconductor-based memory that can be read and
written by the microprocessor or other digital hardware devices

Range: A continuous band of signal values that can be measured or sourced. In bipolar
instruments, the range includes positive and negative values.

Real-Time: Pertaining to a system or operating mode under which computation is
performed during the actual time when an external process occurs, instead of being
accumulated and processed at a later time. The computation results can therefore be used
to control, monitor, or respond in a timely manner to the external process.

Remote: A connection using modems between a Hydran M2 With Models and a host
computer through a public or private telephone system

Remote Site: Location of the Hydran M2 With Models

Repeatability: The ability of an instrument to measure the same input to the same value
over a short period of time and over a narrow temperature range
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Response Time: For a measuring instrument, designates the time between the application
of a step input signal and the indication of its magnitude within a rated accuracy. For a
sourcing instrument, designates the time between a programmed change and the avail-
ability of the value at its output terminals.

RFI: Radio-Frequency Interference

%RH: Relative Humidity in %

RMS: Root Mean Square

RS-232: Specific type of port on the back of some computers, or peripherals such as
modems. It has 9 or 25 pins.

RS-232 Serial Communication Link: Cable that connects a Hydran M2 With Models or
a network of Hydran M2 With Models to a laptop computer

RS-485 Network Link: Cable that connects Hydran 201Ci Controllers together to form a
network

RTC: Real-Time Clock

SCADA: Supervisory Control And Data Acquisition. Identifies the numerous devices
(control panel, alarm panel, retransmission unit, display, terminal, data recorder, external
detection device, etc.) on which can be connected the components of the Hydran M2 With
Models.

SH: SHield

SP: Set Point

SPDT: Single Pole Double Throw

Submenu: A branch of the treelike structure of a menu

Supervisory Link: Cable connecting a Hydran M2 With Models to a Hydran 201Ci
Controller

TB: Terminal Block
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TB4: Terminal Block 4, a term inherited from the Hydran 201R (previous generation of
transformer incipient fault monitor), in which there were also TB1, TB2 and TB3

Teflon: polyTEtraFLuOrethyleNe

TM: TradeMark

Transformer Oil: Highly-refined, mineral oil used as a dielectric and heat transfer fluid in
transformers

User: Person operating the Hydran M2 With Models

User-Friendly: An interface designed to simplify the use of an application

User Interface: The means (display, keypad, push button, etc.) used to achieve communi-
cation between the user and a Hydran M2 With Models

µV: Microvolt

V: Volt

VA: Volt-Ampere

Vac: Volt Alternating Current

Vdc: Volt Direct Current

VDE: Verein Deutscher Elektrotechniker, a german standards institute

Vibration-Absorbing Rubber Pad: Device used to protect a Hydran 201Ci Controller
against vibrations

W: Watt

WAN: Wide Area Network, a communication network using telephone lines or other
telecommunication devices to link computers in geographically-separated areas

Watchdog: Process used periodically to test if a computerized system is operating properly

% w/w: Percentage Weight by Weight
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